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 Purpose statement 
This general module describes the performance outcomes, skills and knowledge to apply 

Computerized accounting skills in performing customs and tax operations and its management to 

develop a comprehensive and clear vision of the custom and taxes knowledge and the training 

program. At the end of this module, learners will be able to Apply computerized Accounting in tax 

operations, Use accounting software SAGE 100 and produce financial reports, Understand the Use 

of TALLY Accounting software, Understand Introduction to SMART GOV, Understand Electronic 

Single Window and Understand the application of QuickBooks
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Learning Unit 1: Apply Computerized Accounting In Tax 

Operations 

LO 1.1 – Understanding computerized accounting systems  

● Content/Topic 1: Introduction to computerized accounting concepts   

Definition; A computerized accounting system is an accounting information system that processes 

the financial transactions and events as per Generally Accepted Accounting Principles (GAAP) to 

produce reports as per user requirements. 

Computerised Accounting System refers to the processing of accounting transaction through the use of 

hardware and software in order to produce accounting records and reports. 
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System software 

 

Application software 
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Computerized accounting system (CAS) takes accounting transactions as inputs that are processed 

through Accounting Software to generate the following reports: 

• Day books/Journals 

• Ledger 

• Trial Balance 

• Position Statement (Balance Sheet) 

• Statement of Profit and Loss (Profit and Loss Account) 

 

Basic flow of Accounting Transactions 

 

Input transactions    Data entry   accounting application software  accessed-queries 

information displayed or printed. 

A database is an organized collection of data, generally stored and accessed electronically from a 

computer system. For example, a company database may include tables for products, employees, 

and financial records.  

Accounting Framework: It consists a set of principles, coding and grouping structure of accounting. 

Operating Procedure: It is a well-defined operating procedure blended suitably with the operating 

environment of the organization. 



 

Page 4 of 171 
 

Data Processing: It is a sequence of actions that are taken to transform the data into decision 

useful information. 

Reporting System: It is an integrated set of objects that constitute the report. 

Computer software, or just software, is a collection of computer programs and related data that 

provide the instructions for telling a computer what to do and how to do it. 

Accounting software is application software that records and processes accounting transactions 

within functional modules such as accounts payable, accounts receivable, payroll, and trial balance 

etc. 

 

 

 Content/ Topic 1.2 :The comparison between manual and computerized Accounting 

The deference between manual accounting system and computerized accounting system depends 

on speed for processing business transactions and their accuracy reports. The table below shows 

the comparison between manual accounting system and computerized accounting system as 

follow;  

Basis Manual Accounting Computerized Accounting 
1.Recording of 

transactions  

Transactions are recorded manually. Transactions are recorded using 

computer. 

2. Storage  Transactions are stored in volumes of 

books 

Transactions are stored in well-

designed databases. 

3. Preparation of 

ledger of 

account, trail 

balance and 

financial 

statement. 

Ledger accounts, trial balance and financial 

statements are prepared manually 

Once the journal entries are passed 

or subsidiary books are entered, data 

are processed automatically and 

ledger accounts, trial balance and 

balance sheet are automatically 

prepared. 

4.Preparation of 

report 

Analysis of financial statements and 

preparation of report are done manually  

Financial statement analysis such as 

ratio analysis, preparation of cash 

flow analysis etc, is automatically 

done. 
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5.Time involved -It takes lot of time as everything from 

journalizing to report generation is done 

manually. 

 

 

-With the manual accounting system, it 

take time to locate the information from 

each book and compile (collect) it into the 

report. 

 

 

 

-Time is taken only for passing 

journal entries, once data are 

entered, preparation of ledgers trial 

balance, financial statements or 

report generation is done within 

seconds. 

-With computerized accounting 

system, information or reports for 

particular period of time can be 

compiled quickly.    

6.Cost involved  The cost is high in manual accounting 

system as several books of account are to 

be maintained. 

The cost is less compared to manual 

accounting system as well the 

records are kept in softcopy.  

7. Accuracy  Certain clerical error such as arithmetical, 

error, error in carrying forward, etc can 

happen. 

If input given is correct, the output 

will also be correct. Arithmetic error, 

error in carrying forward will not 

happen provided programming is 

correct. 

8.Classification Transactions   recorded   in   the   books of 

Original entry are classified in order to 

produce ledger accounts. 

No such data duplications are made. 

9.Summarizing Transactions are summarized to produce 

trial balance. 

The generation of ledger accounts is 

not necessary condition for Trial 

balance 

10.Financial The preparation of FS (Financial 

statement) assumes the availability of 

Trial balances 

The preparation of FS  is independent 

of producing Trial balance 

 

● Content/Topic 3 :Discussion on the advantages and disadvantages of computerized 

a) Advantages of computerized accounting systems 

The Computerized accounting offers several advantages vis-a-vis manual accounting system, these 

are summarized as follows; 

Speed: Accounting data is processed faster by using a computerized accounting system than it is 

achieved through manual efforts. This is because computers require far less time than human 

beings in performing a task. 
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Accuracy: The possibility of error is eliminated in a computerized accounting system because the 

primary accounting data is entered once for all the subsequent usage and processes in preparing 

the accounting reports. Normally, accounting errors in a manual accounting system occur because 

of repeated posting of same set of original data by several times while preparing different types of 

accounting reports. 

Reliability: The computer system is well-adapted to performing repetitive operations.  As a result, 

computers are highly reliable compared to human beings. Since computerized accounting system 

relies heavily on computers, they are relatively more reliable than manual accounting systems. 

Up-to-Date Information: The accounting records, in a computerized accounting system are 

updated automatically as and when accounting data is entered and stored. Therefore, latest 

information pertaining to accounts get reflected when accounting reports are produced and 

printed. For example, when accounting data pertaining to a transaction regarding cash purchase of 

goods is entered and stored, the cash account, purchase account and also the financial statements 

(trading and profit and loss account) reflect the impact immediately. 

Real Time User Interface: Most of the automated accounting systems are inter-linked through a 

network of computers. This facilitates the availability of information to various users at the same 

time on a real time basis (that is spontaneously). 

Automated Document Production: Most of the computerized accounting systems have 

standardized, user defined format of accounting reports that are generated automatically. The 

accounting reports such as Cash book, Trial balance, Statement of accounts are obtained just by 

click of a mouse in a computerized accounting environment. 

Scalability: In a computerized accounting system, the requirement of additional manpower is 

confined (restricted) to data entry operators for storing additional vouchers. The additional cost of 

processing additional transactions is almost negligible. As a result the computerized accounting 

systems are highly scalable (accessible). 

Legibility: The data displayed on computer monitor is legible. This is because the characters 

(alphabets, numerals, etc.) are type written using standard fonts. This helps in avoiding errors 

caused by untidy written figures in a manual accounting system. 
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Efficiency: The computer based accounting systems ensure better use of resources and time. This 

brings about efficiency in generating decisions, useful information and reports. 

Quality Reports: The inbuilt checks and untouchable features of data handling facilitate hygienic 

and true accounting reports that are highly objective and can be relied upon. 

MIS Reports: The computerized accounting system facilitates the real time production of 

management information reports, which will help management to monitor and control the 

business effectively. Debtors’ analysis would indicate the possibilities of defaults (or bad debts) and 

also concentration of debt and its impact on the balance sheet. For example, if the company has a 

policy of restricting the credit sales by a fixed amount to a given party, the information is available 

on the computer system immediately when every voucher is entered through the data entry form. 

However, it takes time when it comes to a manual accounting system. Besides, the results may not 

be accurate. 

Storage and Retrieval: The computerized accounting system allows the users to store data in a 

manner that does not require a large amount of physical space. This is because the accounting data 

is stored in hard-disks, CD-ROMs, floppies that occupy a fraction of physical space compared to 

books of accounts in the form of ledger, journal and other accounting registers. Besides, the system 

permits fast and accurate retrieval of data and information. 

Motivation and Employees Interest: The computer system requires a specialised training of staff, 

which makes them feel more valued. This motivates them to develop interest in the job. However, 

it may also cause resistance when we switch over from a manual system to a computer system. 

b) Disadvantages of Computerized Accounting 

1. Loss of data because of virus attack. 

2. It can cause diseases like cancer and eye diseases due to intact of electrical gadgets. 

3. Easily forgetting normal accounting procedures etc 

4. Depends on the availability 

5. It requires highly skilled/experienced personnel. 

Content/ topic 4:The limitations of computerized accounting systems 

The main limitations emerge out of the environment in which the computerized accounting system 

is made to operate. These limitations are as given below; 
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Cost of Training: The sophisticated computerized accounting packages generally require specialized 

staff personnel. As a result, a huge training costs are incurred to understand the use of hardware 

and software on a continuous basis because newer types of hardware and software are acquired to 

ensure efficient and effective use of computerized accounting systems. 

Staff Opposition: Whenever the accounting system is computerized, there is a significant degree of 

resistance from the existing accounting staff, partly because of the fear that they shall be made 

redundant and largely because of the perception that they shall be less important to the 

organization. 

Disruption: The accounting processes suffer a significant loss of work time when an organization 

switches over to the computerized accounting system. This is due to changes in the working 

environment that requires accounting staff to adapt to new systems and procedures. 

System Failure: The danger of the system crashing due to hardware failures and the subsequent 

loss of work is a serious limitation of computerized accounting system. However, providing for 

back-up arrangements can obviate this limitation. Software damage and failure may occur due to 

attacks by viruses. This is of particular relevance to accounting systems that extensively use 

Internet facility for their online operations. No full- proof solutions are available as of now to tackle 

the menace of attacks on software by viruses. 

Inability to Check Unanticipated Errors: Since the computers lack capability to judge, they cannot 

detect unanticipated errors as human beings commit. This is because the software to detect and 

check errors is a set of programmers for known and anticipated errors. 

Breaches of Security: Computer related crimes are difficult to detect as any alteration of data may 

go unnoticed. The alteration of records in a manual accounting system is easily detected by first 

sight. Fraud and embezzlement are usually committed on a computerized accounting system by 

alteration of data or programmes. Hacking of passwords or user rights may change the accounting 

records. This is achieved by tapping telecommunications lines, wire-tapping or decoding of 

programmes. Also, the people responsible for tampering of data cannot be located which in a 

manual system is relatively easier to detect. 
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Ill-effects on Health: The extensive use of computers systems may lead to development of various 

health problems: bad backs,muscular pains, etc. This affects adversely the working efficiency of 

accounting staff on one hand and increased medical expenditure on such staff on the other. 

 Content/ topic 5 :The sourcing of computerized accounting software or accounting 

packages 

Accounting software is an integral part of the computerized accounting system. An important factor 

to be considered before acquiring accounting software is the accounting expertise of people 

responsible in organization for accounting work. People, not computers, are responsible for 

accounting. The need for accounting software arises in two situations: 

 (a) When the computerized accounting system is implemented to replace the manual system or  

(b) When the current computerized system needs to be replaced with a new one in view of 

changing needs. 

Accounting Software 

Variety of accounting software is available in the market. The most popular software used in 

Rwanda are Tally and Ishyiga, sage line, quick book etc,  . The basic features of all accounting 

software are same on a global basis. The legal reporting requirements in a given country and the 

business needs affect the software contents.  

● Content /Topic 6: Description of accounting package 

a) Definition accounting package 

 Accounting package is a type of software that accounting professionals or business owners use to 

process accounting transactions and manage accounts.  

It is a piece of software that a business uses to organize its financial records. 

 It is also a set of special routines that allow collection of information about the usage level of 

various components of a computer system by each production program.  

The example Accounting package include Sage line 50, 100, 1000, Quickbooks, sage pastel, Fresh-

books, Sage Line 30/50/100/500/1000, SAP, Oracle Financials, Sage Pastel,Tally etc 

Every Computerized Accounting System is implemented to perform the accounting activity 
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(recording and storing of accounting data) and generate reports as per the requirements of the 

user.   

b) Classification of accounting package 

The accounting packages are classified into the following categories: 

(a) Ready to use 

(b) Customized 

(c) Tailored 

Each of these categories offers distinctive features. However, the choice of the accounting software 

would depend upon the suitability to the organization especially in terms of accounting needs. 

1) Ready-to-Use 

Ready-to-Use accounting software is suited to organization running small/ conventional business 

where the frequency or volume of accounting transactions is very low. This is because the cost of 

installation is generally low and number of users is limited. Ready-to-use software is relatively 

easier to learn and people (accountant) adaptability is very high. This also implies that level of 

secrecy is relatively low and the software is prone to data frauds. The training needs are simple and 

sometimes the vendor (supplier of software) offers the training on the software free. However, 

these software offer little scope of linking to other information systems. 

2) Customized  

Accounting software may be customized to meet the special requirement of the user. Standardized 

accounting software available in the market may not suit or fulfil the user requirements. For 

example, standardized accounting software may contain the sales voucher and inventory status as 

separate options. However, when the user requires that inventory status to be updated 

immediately upon entry of sales voucher and report be printed, the software needs to be 

customized. 

Customized software is suited for large and medium businesses and can be linked to the other 

information systems. The cost of installation and maintenance is relatively high because the high 

cost is to be paid to the vendor for customization. The customization includes modification and 

addition to the software contents, provision for the specified number of users and their 
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authentication, etc. Secrecy of data and software can be better maintained in customized software. 

Since the need to train the software users is important, the training costs are therefore high. 

3) Tailored 

The accounting software is generally tailored in large business organizations with multi users and 

geographically scattered locations. These software requires specialized training to the users. The 

tailored software is designed to meet the specific requirements of the users and form an important 

part of the organizational MIS. The secrecy and authenticity checks are robust in such softwares 

and they offer high flexibility in terms of number of users. 

To summarize, the following table represents the comparison between the various categories of 

accounting software: 

Basis Ready to use Customized Tailored 

Nature of business Small business Large, medium business Large, business 

Cost of installation and maintenance Low Relatively high High 

Expected Level of secrecy Low Relatively high Relatively high 

Number of users Limited As per Unlimited 

Linkage to other Restricted yes Yes 

information system    
Adaptability High Relatively high Specific 

Training requirements Low Medium High 

 

c) Types of accounting package 

Types of accounting package include; 

1. Sage Line 30/50/100/500/1000 

2. QuickBooks 

3. SAP 

4. Oracle Financials 

5. Sage Pastel 

6. Tally 

 

 

 

 



 

Page 12 of 171 
 

L.O 1.2–Applytaxaccountingincomputerizedaccountingsystems 

● Content / Topic1Apply tax accounting in computerized accounting system 

1) Definition of tax accounting 

Tax accounting refers to the rules, procedures, and processes undertaken by an accountant to 

prepare tax returns and payments for businesses. 

Tax accounting is governed by the Internal Revenue Code, which dictates the specific rules that 

companies and individuals must follow when preparing their tax returns. 

 Tax accounting is the subsector of accounting that deals with the preparations of tax returns 

and tax payments. 

 Tax accounting is used by individuals, businesses, corporations and other entities 

Tax accounting is the means of accounting for tax purposes. It applies to everyone; individuals, 

businesses, corporations, and other entities.  

Even those who are exempt from paying taxes must participate in tax accounting. The purpose of 

tax accounting is to be able to track funds (funds in as well as funds going out) associated with 

individuals and entities.  

2) Compute tax 

a) VALUE ADDED TAX (VAT) 

VAT is a tax on the consumption of goods and services. It is indirectly paid by the final consumer of 

the goods or service. 

The Computation of VAT  

 Before computing tax (VAT) in sage lines you have to setup the rate in software that recommended 

by government because taxes are collected by businesses on behalf of the government, in Rwanda 

we use 18% as VAT rate.  

So to setup VAT rate the following steps should be respected; 

a) In sage line 50;  

1. by using sage line 50 Click on settings >> tax code  
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2. Select T1 with VAT standard of 17.5 and then click on edit. 

 

3 After editing the standard VAT (17.50), and change it with 18 % then click ok. 
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b) Computation of Tax in sage line 50 

Computation of tax especially VAT in accounting software, depends on which way VAT is calculated. 

If VAT is excluded, all transactions of goods purchased and sold are made on the following way; 

1. By using sage line 50 click POP (Purse order processing) or SOP (Sales order processing) 

2. Click new>> select customer or supplier 

3. Select item purchased or sold  

4. Click ok 

5. Entering quantity purchased or sold then 

6. Click save and close 

If VAT is inclusive, the calculation of VAT ofall transactions of goods purchased or sold are made 

on the following way; 

1. By using sage line 50 click POP (Purchases order processing) or SOP (Sales order processing) 

2. Click new>> select customer or supplier 

3. Select item purchased or sold  

4. Click ok 

5. Entering quantity purchased or sold  

6. Double click on the column of VAT and Edit line table appears 
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7. Click on calculate net and then ok then  

8. Click save and close 

If VAT rate is exempted, the computation of VAT is made as follow; 

1. By using sage line 50 click POP (Purchase order processing) or SOP (Sales order processing) 

2. Click new>> select customer or supplier 

3. Select item purchased or sold  

4. Click ok 

5. Entering quantity purchased or sold  

6. Double click on the column of VAT and Edit line table appears  

7. On  the edit line table, select  tax code and choose (T0) and then ok  

8. Click save and close 

c) Presented final accounts 

The term "final accounts" includes the trading account, the profit and loss account, and the balance 

sheet, VAT report etc. 

Before running final reports, ensure all transactions for the period are well posted and user of 

accounting software the following steps; 

i) For VAT report  

1. By using sage line 50 click on financials then click on VAT 
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2. Click on calculate VAT  

3. Click print and VAT return appears  

 

4. When VAT Return appears, click on Run to generate report. 

 

5 report is generated 



 

Page 17 of 171 
 

 

 

To generate other final account the following steps should be followed 

1. By using sageline 50 click financials the report 

2. After  Click on the report, the financial report appears  

3. Double click on select report folder to open the folder  

4.  After opening and selecting the folder, 

5. click on generate report and then click ok 

 

L.O 1.3 – Apply general setting 

● Content/Topic 1. Apply general settings to make a change recorded by default 

I. General setting menu of sage line 50  

The general settings is the menu of sage line 50 that helps you to make change on the information 

recorded by default. 

Click on settings on the menu bar Click on the menu required. 
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a) Company preferences 

The Company Preferences dialog box has eight panels. It’s worth looking through these now. In 

particular, check the Address and VAT details and the options on the Parameters and Budgeting 

panels. 

1. From the sage line 50, click Settings and select Company Preferences. 

2. On the Address panel , enter our contact details if they are not already there. These will 

be used on your letters and  invoices. 

3. On the Parameters panel, set the options as required. 

4. On the VAT tab, check the settings and enter your details for online submissions. 

5. On the Budgeting tab ,leave the Method as Standard to have a basic monthly budget 

against individual nominal accounts, or change to Advanced and select the  Type. 

6. Click ok 
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b) Apply other settings  

 

I) Change currency  

1. From the Sage 50, click Settings >Currencies. 

2. From the Currencies window, in the list of currencies select currency base and click Edit. 

3. The Edit Currency window appears. 

4. Enter the new currency details. 

5. Click Save to add the details to the currency window. 

II) Enter the financial year 

To change your financial year 

1. From the Sage 50 Accounts menu bar, select Settings > Financial Year. 
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The Financial Year window appears showing your current financial year start date. 

1. To change your financial year click change 

A warning appears informing you that you should run the Check Data option and takes a full backup 

of you data. 

2. If you have not done this, do not continue with this procedure and click No. If you have run 

the data check option and taken a full backup, click Yes. 

A warning message appears: 

3. If your Financial Year start date is changed, ALL Nominal historical data-that is, Prior Year 

values, will be cleared. Are you sure you wish to continue? 

4. Click Yes to continue, or click No to cancel and return to the Financial Year window. If you 

click Yes, the Change Financial Year window appears. 

5. From the drop-down list, select the month you want to change the Financial Year Start Date 

to and type the correct year in the corresponding box. 

6. To change the Financial Year, click OK, otherwise click Cancel. 

7. A confirmation message appears. If you are sure that you want to change your financial year 

and have all period balances re calculated, click Yes .If   year, click No. 

8. If you have chosen to change your financial year, a message appears telling you when the 

operation has been completed. 

9. Click OK to return to the Financial Year window, and click OK again to return to the Sage50 

Accounts desktop. 

10. Enter the account status 

III) To change the user password 

The Change Password facility allows you to change the password associated with your current  Sage 

50 Accounts username. 

1. From the Sage 50 Accounts menu bar, select Settings >>>Change Password. 

2. If you already have a password, the Password Entry window appears asking you to enter 

your current password here. 

3. The Change Password window appears. 

4. In the New Password box, enter your new password. 

5. You can use letters or numbers in your passwords, or a mixture of both. 
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6. In the Confirm New Password box, enter your new password again. You cannot save this 

password until the entries in the New Password and Confirm New Password are the same. 

7. To save your new password, click OK.  To begin entering your new password again, click 

Discard. To exit without saving, click Cancel. 

IV) To Set the Program Date 

When ever a date is required, the current date will be set as the default, but it can be easily 

changed. If you intend to process a lot of transactions with the same date– and not today’s – 

set the Program Date before you start. 

1. Open the Settings menu and select Change Program Date. 

2. Set the date by typing or by using the calendar display. 

3.  Set the date and click OK. 

 

 

V) Customer default 

These defaults are applied to the new transactions on customers’ accounts .They 

should be set to the most commonly used VAT code, nominal 

code(N/C),department (if any) and discount rate. Most of these can be set by 

selecting from a drop-down list. 
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The Statements panel simply holds the descriptions to be applied to invoices, credit notes and 

other print-outs. You can probably leave this as it is. 

Set the customer defaults: Ageing 

Chasing debts efficiently is a key part of good cash flow management. Aged Analysis groups 

overdue debts, with the default settings in multiples of 30 days. You can switch to calendar month 

grouping or set your own limits. At which point do you start counting? How old is a debt before you 

send a reminder, and how much older before you send for the lawyers? 

1. If necessary, switch to the Ageing tab. 

2. Select Calendar Monthly Ageing or Period Ageing. 

3. If you select Period Ageing, check the limits for each period and change them if 

necessary. 

4. Tick the box if you want to include the future total in balance. 

5. Click OK. 

 

se 

 

 

se se
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VI)  Supplier defaults 

1. From the sage 50, click Settings > Supplier Defaults. 

 

The Supplier Defaults window appears. 

2. In the boxes provided, enter your supplier record defaults. 

3. To save your supplier defaults and exit click OK, or to exit without saving click Cancel. 

4. The defaults you have entered here will be entered automatically in each new supplier record 

you create. Supplier records that already exist will not be affected by these new defaults. 
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L.O. 1.4- Understanding the generic considerations before sourcing accounting software 

 

 Content /Topic1 Understanding generic considerations before sourcing accounting 

software 

The generic considerations before sourcing accounting software are; 

a) Flexibility 

An important consideration before sourcing an accounting software is flexibility .Data entry, the 

availability and design of various reports expected from it. Also, it should offer some flexibility 

between the users of the software ,the switch over between the accountants(users),operating 

systems and the hardware .The user should be able to run the software on variety of platforms 

andmachines,e.g.Windows98/2000,Linux,etc. 

b) Cost of Installation and Maintenance 

The choice of the software obviously requires consideration of organization 

ability to afford the hardware and software. 

A simple guideline to take such a decision is the cost benefit   analysis of the available options and 

the financing opportunities available to the firm.  Sometimes, certain software which appears 

cheap to buy, involve heavy maintenance and alteration costs, e.g. cost of addition of modules, 

training of staff, updating of versions, data failure/restoring costs. Conversely, the accounting 

software which appear initially expensive to buyers, may require least maintenance and free 

upgrading and negligible alteration costs. 

c) Size of Organization 

The size of organization and the volume of business transactions do affect the software choices. 

Small organizations, e.g. in non-profit organizations, where the number of accounting transactions 

is not so large, may opt for a simple, single user operated software. While, a large organization may 

require sophisticated software to meet the multi-user requirements, geographically scattered and 

connected through complex networks. 

d) Expected Level of Secrecy (Software and Data) 

Another consideration before buying accounting software is the security features, which prevent 

unauthorized personnel from accessing and/or manipulating data in the accounting system.  
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In tailored software for large businesses, the user rights may be restricted to purchase vouchers for 

the purchase department, sales vouchers to the billing accountants and petty cash module access 

with the cashier. The operating system also matters. Unix environment allows multi-users 

compared to Windows. In Unix, the user cannot make the computer system functional unless the 

user clicks with a password, which is not a restriction in Windows. 

e) Exporting/Importing Data Facility 

The transfer of database to other systems or software is sometimes expected from the accounting 

software. Organizations may need to transfer information directly from the ledger into spreadsheet 

software such as Lotus or Excel for more flexible reporting. The software should allow the hygienic, 

untouched data transfer. 

Accounting software may be required to be linked to MIS (Management Information System) 

software in the organization. In some ready to use accounting software, the exporting, importing 

facility is available but is limited to MS Office modules only, e.g. MS Word, MS Excel, etc. However, 

tailored software are designed in manner that they can interact and share information with the 

various sub components of the organizational MIS. 

f) Vendors Reputation and Capability 

Another important consideration is the reputation and capability of about the vendor. This 

depends upon how long has he been the vendor is in business of software development, whether 

there are other users of the software and extent of the availability of support mechanisms outside 

the premises of the vendor. 
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Learning Unit LU2 – Use  Accounting  Software  SAGE50  and Produce 

Financial Statement 

L.O.2.1 - Creating a new customer record 

 Content/Topic 1 Apply sage 50 to create a customer record 

I) Introduction 

In the Sage 50 systems, customers are handled in almost identical ways, as you might expect it is 

the same trading relationship, but viewed from opposite ends. The examples in this learning 

outcome is drawn from the Customers module. 

II) Record 

From the Main menu bar choose customer and then edit customer. The customer record screen 

will appear showing the details tab first. Create an account name being up to 8 characters (letters 

and/or numbers), it is easier to use the first letters of the customers name i.e. Mr Nevett would 

have an account name as NEVETT or NEVETT01 Complete the remaining detail fields accordingly in 

the boxes provided Choose the Defaults tab; choose Def N/C this should be a 4000 code for sales, 

check how the sales are to be posted. Choose Def Tax Code, if the sales to this customer are vatable 

the code will be TI for 17.5% if the goods are zero rated this will be T0 for 0% VAT, refer to the tax 

codes schedule on page 14. Choose the Credit Control tab and tick the box terms agreed, this will 

stop a warning appearing on the screen advising that terms have not been agreed. 

One can choose any of the tabs from the record and enter information about the customer. 

a) Create a customer record  

To create a customer record the following steps should be followed; 

1. By using sage line 50 click customers module 

2. Click record 

3. To record customer’s information start from details to record information such as; 

1. Customer accounts 

2. Customer’s name and 

3. Customer address 
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III) Use Wizard to create a new customer  

From the main menu bar choose customer, new customer. The wizard will guide you through the 

procedures to follow and input the information required. (Please note that not all of the fields will 

need to be completed) If the information you have entered is correct and you wish to save the 

account created click save in the bottom corner. 

If you do not wish to save any of the information click discard. 

The screen will now be blank and new record details can be posted, to exit the record click close. 

b) Create a customer record wizard 

Wizards are there to guide you through the trickier routines. You will meet them when you first 

set up Sage 50, whenever you create a new customer, supplier or other account, when you are 

doing transfers within your Nominal Ledger, and in similar situations. They help to ensure that you 

supply the right kind of information and that it goes into the right place. Here’s the New Customer 

Wizard as an example. 

Accounts can be set up from the New button in the customers list in those windows that handle 

invoices, receipts and payments a blank record opens to take the details. However, the simplest 

way is to use the New wizard in the Customers modules. This helps to ensure that all essential 

information is entered and creates an A/C (account) reference for   you.  
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1. Open the Customer module and click New. 

2. Click Next to get started and Next after each stage. 

3. Enter the name. An A/C Ref will be generated edit this to make it easier to recognize, if 

necessary. 

4. Enter the address details. 

5. Enter the contact details and set the Account Status – normally Open (active, existing  

client)  or New. 

6. At the three Additional Information stages, check and adjust the Credit Limit and Terms as 

required. If terms have been agreed with the customer, tick the checkbox at the second 

stage – until this is ticked, you will get a reminder every time you open the account. 

7. Enter the customer’s bank details if payments are to be by Bank. 

8. If you are bringing an existing customer onto the system, you may need to set the opening 

balance. This can be entered as a set of individual transactions, or as a single value. 
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 Content/ Topic 2 :Apply computerized accounting module to record customer invoice 

A) Customer Invoices 

This option is used for invoices produced manually; this will therefore not produce printable sales invoice .If 

you require a printable invoice refer to Integra Accounting Limited or the sage users/help guide for further 

assistance. Choose customer from the main toolbar and then invoice In the A/C field choose the customer’s 

name i.e. NEVETT, you can click the blue arrow and scroll or just type NE to go straight to the customer. 

Date - as invoice date 

Ref - as invoice number 

E/X Ref - does not need to be completed 

N/C 4000… depending on the sales structure 

Dept - does not need to be completed 

Project Ref - does not need to be completed, this can be used for project costing 

Details - Refer to invoice or type in the details from the invoice raised 

Net - Amount charged before VAT 

T/C - T1 17.5%, T0 0% (see tax code schedule on page 14) 

VAT - Amount of VAT charged 
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Ensure that the total box on sage agrees to the invoice. The VAT box can be overtyped for any small 

rounding differences. 

Press Save 

If you do not wish to save the information press discard 

To exit this screen press close 

The invoice will now be showing on sage as a Debtor (Being money due from a customer) and as 

sales revenue generated on the profit and loss. 

B) Recording a batch customer invoice 

 

From the Customers window, choose the customers that you want to create a batch invoice for. 

Click Invoice. 

 

 

The Batch Customer Invoices window appears. 

1. For each invoice item, or whole invoice, enter the invoice details, one line at a time. 

Enter account (a/c) code > Change invoice date if it is different from the current system >Enter the 

invoice number > Change nominal code if different from defaults>Enter net value of invoice. 
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2. If you calculate the batch totals manually before you entered them into Sage 50Accounts, check 

your batch totals against those shown on the Batch Customer Invoices window. 

Other boxes displayed in this window show the Account Code, Nominal Code and Tax Rate. 

3. To accept your entries, click Save .The details update the Nominal Ledger and the relevant 

customer’s details. 

If you do not wish to save this batch, then to clear the data and start again, click Discard .The 

Discard button does not cancel any batch entries you have already saved. 

To exit the Batch Customer Invoices window and return to the Customers window, click Close. 

 Content/ Topic 3 Apply customer module to record customer credit note 

a) Introduction  

To post a credit note choose customer from the main toolbar and then credit Follow all of the steps 

above to enter the credit note If an invoice is in dispute, this can be shown by going in to manage 

credit control and marking the item as being in dispute. The reports and payment screen will then 

show the invoice with a 'd' by the side in order that you are aware of the dispute. 

The dispute reasons will need to be set-up prior to using this facility. 
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NOTE 

When you post the invoices on to sage you can enter several lines if the invoice has a number of 

products listed. To ensure the invoice is listed as one invoice and to group the items you will be 

required to post each line with the same A/C code, Date and Ref number. 

b) Recording a batch customer credit note 

 

Credit note is a form or letter sent by a seller to a buyer, stating that a certain amount has been 

credited to the buyer's account. 

A credit note is issued in various situations to correct a mistake ,such as when(1)an invoice amount 

is overstated,(2)corrected is count rate is not applied,(3)goods spoil within guaranty period 

,or(4)they do not meet the buyer's specific actions and are returned. Al so called credit memo. 

Use the Credit facility to log any credit notes you have produced manually ,and sent to your 

customers. 

1. From the Customers window, choose the customers that you want to create a batch credit 

note for. 

2. Click Credit. 

 

The Batch Customer Credits window appears. 

Enter the customer account code >Enter credit details for each customer > Check all values if are 

correct > Click save and close to return to customer window. 
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1. For each credit note item, or whole credit note, enter the details one line at at ime. 

IfyoucalculatedthebatchtotalsmanuallybeforeyoustartedenteringthemintoSage50 Accounts, check 

your batch totals against those shown on the Batch Customer Credits window. 

2. To accept your entries click Save. 

The details update the Nominal Ledger and the relevant customer’s details. 

If you do not wish to save this batch, click Discard to clear the data and start again. The Discard 

button does not cancel any batch entries you have already saved. 

3. To exit the Batch Customer Credits window and return to the Customers window, click 

Close. 

c) Posting a customer receipt  

For Receipts: 

1. The selected bank account is increased by the amount received (a debit posting). 

2. The amount owed to you, shown in the Debtors Control account, is reduced by the amount 

received (a credit posting). 

For Discounts You Have Given: 

3. The amount owed to you, shown in the Debtors Control account, is reduced by the amount 

discounted (a credit posting).  

4. The Sales Discount nominal account receives the value of the discount given (as a debit 

posting). This has the effect of reducing your overall sales figures.  

5. The customer payments appear on the audit trail as the following transaction types: 

 

   SR = Receipts from a customer (sales receipts) 
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   SD = Discount to a customer (sales discount) 

 

   SA = Receipts from a customer on account (sales payment on account) 

 

 

d) Posting a customer  credit note 

1. A sales credit note is posted to the customer’s account with the same reference as the 

refunded invoice. The details field contains Sales Refund and the tax and sales nominal 

account codes will be the same as the original invoice. 

2. A dummy sales invoice is posted to the customer’s account with the same reference as the    

refunded invoice. The details field contains Sales Refund, the tax code will be T9 and the 

nominal code will be that of the misposting control account.  

3. The invoice is allocated in full to the credit note described above. 

4. The account’s turnover is reduced by the net amount of the new credit note posting, 

excluding any VAT. 

5. The account’s balance is not affected, and neither is the amount paid this period total. 

6. The nominal account for sales, as used for the refunded invoice, is reduced by the net 

amount of the refund, excluding any VAT (a debit posting). 

7. If VAT was included in the sale, the amount of VAT you need to pay on sales, as shown in the 

Sales VAT control account, is reduced by the VAT amount of the refunded invoice (a debit 

posting). 

8. The money in the bank control account is increased with the total value of the new invoice, 

and reduced by the total amount of the refund, resulting in a zero effect. 
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9. The total amount owed to you by your customers, as show in the debtors control account 

balance in the nominal ledger, remains unaffected. 

 

 

LO. 2.2: Creating a supplier record 

 Content/ Topic 1 :Apply supply module to create a supply record 

a) Record 

From the Main menu bar choose supplier and then edit supplier. The supplier record screen will 

appear showing the details tab first. 

Create an account name being up to 8 characters (letters and/or numbers), it is easier to use the 

first letters of the suppliers name i.e. Integra Accounting Limited would have an account name as 

INTEGRA or IAL etc 

Complete the remaining detail fields accordingly in the boxes provided Choose the Defaults tab, 

choose Def N/C this should be a 5000 onwards code for a profit and loss expense (Refer to the 

nominal code list – Purchases for resale would be 5000, accountancy is 7601). 

Choose Def Tax Code, if the supplier and supply is vatable the code will be TI for 17.5% if the goods 

are zero rated this will be T0 for 0% 

Choose the Credit Control tab and tick the box terms agreed, this will stop a warning appearing on 

the screen advising that terms have not been agreed. 

One can choose any of the tabs from the record and enter information about the supplier. 

Create a supplier record  

To create a supplier record the following steps should be followed; 
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4. By using sage line 50 click customers module 

5. Click record 

6. To record supplier’s information start from details to record information such as; 

4. supplier accounts 

5. supplier’s name and 

6. supplier’s address 

 

a) Create a supplier record wizard 

Wizards are there to guide you through the trickier routines. You will meet them when you first 

set up Sage 50, whenever you create a new customer, supplier or other account, when you are 

doing transfers within your Nominal Ledger, and in similar situations. They help to ensure that you 

supply the right kind of information and that it goes into the right place. Here’s the New Customer 

Wizard as an example. 

Accounts can be set up from the New button in the supplier list in those windows that handle 

invoices, receipts and payments a blank record opens to take the details. However, the simplest 

way is to use the New wizard in the supplier modules. This helps to ensure that all essential 

information is entered and creates an A/C (account) reference for   you.  

9. Open the suppliers module and click New. 
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10. Click Next to get started and Next after each stage. 

11. Enter the name. An A/C Ref will be generated edit this to make it easier to recognize, if 

necessary. 

12. Enter the address details. 

13. Enter the contact details and set the Account Status – normally Open (active, existing 

suppliers)  or New. 

14. At the three Additional Information stages, check and adjust the Credit Limit and Terms as 

required. If terms have been agreed with the suppliers, tick the checkbox at the second 

stage – until this is ticked, you will get a reminder every time you open  the account. 

15. Enter the supplier’s bank details if payments are to be by Bank. 

16. If you are bringing an existing customer onto the system, you may need to set the opening 

balance. This can be entered as a set of individual transactions, or as a single value. 
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 Content/ Topic 2:Apply computerized accounting to record  the supplier invoices 

a) Supplier Invoices 

This option is used for invoices received from suppliers, which are due for payment. 

Choose supplier from the main toolbar and then invoice 

In the A/C field choose the suppliers name i.e. INTEGRA, you can click the blue arrow and scroll or 

just type IN to go straight to the supplier. 

Date - as invoice date 

Ref - Each invoice should be numbered in the top right hand corner from 001. onwards and filed in 

number order for ease of reference at a later date 

E/X Ref - does not need to be completed 

N/C 5000… depending on the expense (see nominal codes list) Dept - does not need to be 

completed 

Project Ref - does not need to be completed, this can be used for project costing Cost Code - does 

not need to be completed, this can be used for project costing Details - Inv number and brief detail 

of the goods purchased 

Net - Amount charged before VAT 

T/C - T1 17.5%, T0 0% (see tax code schedule) 

VAT - Amount of VAT charged Ensure that the total box on sage agrees to the invoice. The VAT box 

can be Over typed for any small rounding differences If the invoice does not list the VAT separately 

- In the NET box type in the total of the invoice and then click the cursor in to the tax box and press 

the calculate net button at the bottom of the screen. 
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NOTE: A VAT invoice is required to claim VAT on the purchase. A detailed receipt is required for 

purchases over £250.00, which will list the VAT separately. 

Ensure that the total agrees to the value of the invoice. 

Press Save 

If you do not wish to save the information press discard 

To exit this screen press close 

The invoice will now be showing on sage as a Creditor (Being money due to a supplier) and as an 

expense on the profit and loss. 

From the supplier window, click invoice to bring up the batch supplier Invoices window. 

 

1. Type the supplier account code 

2. Enter the date and other invoice details 

3. When all details are correct, save to post the details Close to return to supplier’s window 

 Content/ Topic 3: Apply Computerized accounting  module to record supplier credit note 

a) Supplier Credit Notes 

To post a credit note Choose supplier from the main toolbar and then credit Follow all of the steps 

above to enter the credit note If an invoice is in dispute, this can be shown by going in to manage 

credit control and marking the item as being in dispute. The reports and payment screen will then 

show the invoice with a 'd' by the side in order that you are aware of the dispute. 

The dispute reasons will need to be set-up prior to using this facility. 

NOTE 

When you post the invoices on to sage you can enter several lines if the invoice has a number of 

products listed. To ensure the invoice is listed as one invoice and to group the items you will be 

required to post each line with the same A/C code, Date and Ref number. 
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If you post a batch of invoices on to the same screen, ensure each invoice has a difference 

reference number to the proceeding one in order that invoices are not grouped together. If each 

invoice is numbered from 001 onwards they will not group. 

b) Batch supplier credit note 

Click credit from the supplier toolbar 

 

 

1. Enter the supplier account code 

2. Enter credit details for each supplier  

3. Check all values are correct 

4. Click save and close to return to supplier window 

 Content/ Topic 4: Recording Supplier Payment in sage line 50 

a) Supplier payment  

This option is for payments made to suppliers, where a purchase invoice is already posted on to 

Sage. 

Choose bank from the main screen this will list all the bank accounts held including credit card and 

petty cash If the funds are being paid from the main current account highlight 1200. If it is a cash 

payment choose 1230 for petty cash. 

Press the supplier icon 

A/C - Supplier name, click arrow and scroll or type IN for Integra Accounting limited etc highlight 

and press OK 

Date - date from cheque book or from bank statement if direct transfer 

Ref - cheque number, debit D/D S/O, bacs etc 

Amount – Amount paid to supplier 

Click the cursor in the payment box, against the invoice being paid and press the pay in full button 

Disputed - a 'd' will be shown if the invoice/s are in dispute 
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If several invoices have been paid with one cheque / bacs press pay in full next to all the invoices 

paid If a discount has been taken type the full amount of the invoice in the payment box and the 

discount amount taken in the discount box. 

Ensure analysis total at the bottom agrees to paid total 

Press Save 

If you make an error or do not wish to save choose discard 

To exit the screen press close 

The payment will now be showing on sage as a debit to the creditor (being money paid to a 

supplier) and as a payment from the bank as a credit. 

NOTE 

If you are on the cash accounting scheme and you are allocating the payment as a payment on 

account as the invoice has not been received you will be asked which tax code to use prior to 

saving. If the supplier is VAT registered and the expense will be vatable post as T1, if the expense is 

not vatable and or supplier is not VAT registered it will be zero rated and posted as TO. 

b) Posting a supplier payment 

For Payments: 

1. The selected bank is reduced by the payment amount (a credit posting). 

2. The amount you owe, shown in the creditors control account, is reduced (a debit posting). 

For Discounts Received: 

3. The amount you owe, shown in the creditors control is reduced by the discount amount (a 

debit posting). 

4. The value of the discount received is posted to the Discount on Purchases nominal account 

which reduces your overall purchase expenses in the profit & loss account (a credit posting). 

5. The supplier payments appear on the audit trail as the following transaction types: 

 PP = Payments to a supplier (a purchase payment). 

  PD = Discount on Purchase payment (a purchase payment discount). 

   PA = Payments to a supplier on account (a purchase payment on account). 

Note: To see the payments you have made against a supplier’s invoice items, use the Activity 

button on the Suppliers window. Double click on the invoice item to see any payments or part 

payments that have been made. 
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c) Posting a supplier invoice credit note 

1. A credit note is posted to the supplier’s account with the same reference as the refunded 

invoice. The details field contains Purchase Refund and the tax and purchase nominal 

account codes will be the same as the original invoice. 

2. A dummy invoice is posted to the supplier’s account with the same reference as the 

refunded invoice. The details field contains Purchase Refund, the tax code will be T9 and the 

nominal code will be that of the mispostings control account.  

3. The invoice is allocated in full to the credit note described above. 

4. The account’s turnover is reduced by the net amount of the new credit note posting, 

excluding any VAT. 

5. The account’s balance is not affected, nor is the amount paid this period total. 

6. The nominal account for purchases, as used for the refunded invoice, is reduced by the net 

amount of the refund, excluding any VAT (a credit posting). 

7. The amount of money in the bank control account chosen is increased by the gross amount 

of the refunded invoice, including any VAT (a debit posting). 

8. The balance of the mispostings account is reduced by the value of the new invoice and 

increased by the total amount of the refund resulting in a zero effect. 
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9. The total amount you owe to your suppliers, as shown in the creditors control account 

balance in the nominal ledger, remains unaffected. 

or 

To record information in supplier credit note, such procedures should be followed; 

1.   From the Suppliers window, select the supplier account(s) that you want to record the credit 

note receipts against. 

2.   Click Credits.The Batch Supplier Credits window appears. 

3.   For each credit note item (or whole credit note), enter the credit note details one line at a time. 

4.   If you calculated the batch totals manually before you started entering them into Sage Line 50, 

check your batch totals against those shown on the Batch Supplier Credits window. 

5.   To accept your entries, click Save. The details are ‘posted’ instantly to update the Nominal 

Ledger and the relevant supplier’s details. 

If you do not wish to save this batch, then click Discard to clear the data and start again. The 

Discard button does not cancel any batch details you have already saved. 

6.   To exit the Batch Supplier Credits window and return to the Suppliers window, click Close. 

 

L.O 2.3 - Posting a bank receipt 
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 Content/ Topic 1: Apply Computerized accounting module for posting a bank receipt 

For Bank, Cash and Credit Card Receipts: 

The selected bank account is increased by the full amount you received (a debit posting). 

The VAT owed to the VAT office increases by the VAT amount (a credit posting to the VAT on Sales 

control). 

The nominal ledger income accounts specified, are allocated the net amount of the transaction 

(exclusive of VAT) as credit postings. 

The receipts appear on the audit trail as the following transaction types: 

  BR = Receipts into a cheque account. 

  CR = Receipts into a cash account.  

  VR = Receipts into a credit card account. 

a) Choose a bank from main screen 
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b) Press payment from the toolbar 
 

 
 
 

c) Fill bank charges paid and cheque book number  

1. From sage line 50 click bank module 
2. Select account from the list of banks account  
3. From bank module, Click supplier toolbar and supplier payment appears  
4. Fill payee, cheque number, payment amounts 
5. Save and close. 
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d) Check transfer between account 
 

1.   From the Sage Line 50 toolbar, click Bank. 
 
2.   From the list of banks accounts displayed, select the bank account you want to move the 
money from. 
 
3.   From the Bank Accounts window toolbar, click Transfer. 
 
The Bank Transfer window appears. 
 
4.   In the boxes provided, enter the transfer details. 
 
Note: Because this option simply transfers money between accounts, no VAT is involved. 
 
5.   To process the transfer, click Save. To re-enter the data, click Discard. Click Close to exit 
from the window. 
 
If you need further guidance, use the wizard to help you transfer your money from one 
account to the other.  
 

 
 
 

 Content/Topic 2: apply bank module to reconcile your accounts 

Reconciliation is one of those chores that cannot be automated fully, but at least the Sage 50 

system makes it straightforward. As you mark items that match entries in your bank statement, the 

system calculates and displays the difference between your recorded end balance and that of the 

bank statement. If they do not match after you have worked through the list, you can see how 

much it is adrift and will probably have a clear idea of the source of the problem. 
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1. From the sage line 50 click bank module   

2. Select an account. 

3. Click Reconcile on the Bank Accounts toolbar. 

4. At the Statement Summary dialogue box, enter the Ending Balance from your 

bank statement the balance in your Sage50 Bank account will have been 

written in as the default. 

5. If the statement shows interest earned or bank charges, enter the amounts 

and select the appropriate N/C codes. 

6. Click OK to open the Bank Reconciliation window. 

7. Work through the list. Select an un match edit in the top list .If you can match it 

with the bank statement ,mark it of on the statement and click Match to move it 

to the Matched list below. 

8. If you do not have the time or the information o complete the reconciliation 

,you can click Save to save the work done so far, then restart the process later 

using the saved data. 

9. When all the items have been reconciled, if the Difference is not ‘0.00’ you need 

to track down the missing transactions, or identify the ones entered incorrectly  . 

When you have found them, click Adjust and enter the details. 

10. When you have finished, click Reconcile. 

11. If there is a difference between your Bank account and the statement amount, you 

can add an adjustment at this point, or choose to ignore the difference. 
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L O 2.4 - Make VAT procedures 

 Content/ Topic 1: Apply VAT in sage line 50 

a) Select nominal ledge  

The Company module covers all of the Nominal ledger work, except for those tasks that relate to 

any of the bank accounts. Though the Nominal ledger is the heart of the accounting system, once it 
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is set up there are relatively few situations in which you will work on it directly. The Nominal 

module is used mainly for viewing records, for performing (fairly rare) journal entries and for 

setting up budgets. It is here that you define the structure of the accounts, set opening balances, 

make journal entries and reversals, compile the VAT return and manage your assets. 

The financial analysis tools and reports and the end-of-period routines can also be reached from 

this module. 

b) View Nominal records 

The record panels have four tabs: 

•Details shows the current balance, and the balance, budget and prior-year figures for each month 

(if present). 

•Graphs shows the same monthly figures in visual form. 

•Activity shows the transactions currently in the audit trail for that account. 

•Memo is a free space in which any notes can be written. To view records: 

1. Switch to the Company module. The Nominal Ledger will be open, showing a list of Nominal 

accounts. 

2. If you want to look at a single record, double-click on it to open it. 

3. If you want to look at several records, select them and click the Record button.  

4. Click Previous or Next to move between the selected    records. 

5. Click on the headings to switch between the tabs.  

6. Click Close when you’ve finished. 
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c) Journal entry  

A journal entry is a transfer between Nominal accounts. Typical uses include relocating amounts 

placed in Suspense, and recording depreciation or the revaluation of stock or other assets. 

Making a journal entry is one of the few situations where you have to do the double- entry book-

keeping yourself rather than leaving it to the system. An entry normally consists of a pair of 

transactions, one debit, one credit. Sometimes there will be more than two, but the total debits 

and credits must always balance–you cannot save the entries until it they do. 

1. Click Journals to open the Nominal Ledger Journals 

window. Give a Reference to identify the journal. 

2. Set the Date. 

3. Set the N/C number of the Nominal account into which the value will be 

moved from Suspense–either type it or pick it from the drop-downlist. 

4. Type the Details. 

5. Enter the amount in the Debitor Credit column–this should be the same 

ideas the original amount which produced the Suspense balancing entry. 

6. Repeat steps4 to 6 for the balancing entry to move the amount out of the 

Suspense account–this will be the opposite debit/credit to the original. 

7. If there are several opening balances to correct, repeat steps 2 to 7 for each of 

them. 

1
0
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8. Click Save. If the total debit and credit entries are not the same ,you will be 

alerted .You can save and exit from the Journals window only when the 

entries balance. 

 

 

 

 Content/Topic 2: Apply financial module to print VAT return analysis 

To print vat return analysis the following steps should be followed, 

1. From the sage line 50, click financial module 

2. Click VAT and VAT tax return window appears 

3. Click calculate VAT, then yes 

4. Click print and VAT return report appears  

5. From VAT return report, select VAT return and print preview 

6. Click RUN and VAT return report appear then  

7. Click print and the ok 



 

Page 56 of 171 
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 Content/ Topic 3: Understanding Tax code 

a) Tax code 

Sage is preset with the following VAT rates, check the settings to clarify. Settings, configuration, tax 

codes. 

T0 Zero Rated at 0% 

T1 Standard Rated at 17.5% in Rwanda T1: 18% 

T2 Exempt Transactions 

T4 Sales to VAT registered EC Customers 

T5 Reduced rate VAT at 5% 

T7 Zero Rated Purchases from EC Suppliers 

T8 Standard Rated Purchases from EC Suppliers 

T9 Out of scope not to be included on VAT return 

Examples of VAT codes 

Upon installation, Sage Line 50 sets the code T1 - standard rate (currently at 17.5%) as the default 

tax code, but in Rwanda T1 has a standard rate of 18%. Tax codes are used to identify the rate of 

VAT to be applied to a given transaction. 

 

b) Transaction type codes 

A transaction code represents a type of payment or bank transaction. You must define a 

transaction code for each type of payment you plan to use, such as manual checks, system checks, 

electronic files, and bills of exchange. You also may define transaction codes for banking services 

you will require, such as deposits and withdrawals. 
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A transaction code will fall into one of the following categories: 

 Cash Payment: This transaction code represents a kind of cash payment, such as a check. You 

will use cash payment transaction codes in the Accounts Payable application. 

 BOE (Bills of Exchange): This transaction code represents a payment agreement that is similar 

to a letter of credit. The agreement can take the form of a draft issued against a bank account 

until the maturity date, or for cashing early at a discounted rate.   

 Bank Service: This transaction code represents banking transactions that debit or credit your 

bank accounts. You will use bank service transaction codes in Accounts Receivable and Cash 

Management. 

Each transaction posted on to sage will show the type of transaction posted, the codes and 

meanings are listed as follows: 

BP          Bank Payment 

CP        Cash Payment 

BR       Bank Receipt 

CR       Cash Receipt 

JD       Journal Debit 

JC          Journal Credit 

SI         Sales Invoice 

SC       Sales Credit Note 

SR         Sales Receipt 

SD       Discount on Sales Receipt 

SA         Sales Receipt on Account 

PI         Purchase Invoice 

PC        Purchase Credit 

PP        Purchase Payment 

PD        Discount on Purchase Payment 

PA       Purchase Payment on Account 

VP        Credit Card Payment 

VR         Credit Card Receipt 

 

 

 

The table below shows the examples of transaction type code of Rabo international bank 
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a) Function keys 

Sage Line 50 uses   function keys to access a number of important features, including the calculator and this 

help system. 

The features assigned to transaction function keys are as follows: 

Key Function 

F1    Displays Help 

F2    Displays system calculator. You can perform calculations and if needed, copy and paste the 

result into a data field 

F3    When editing an invoice this will activate the edit item line window 

F4    Displays calendar, calculator or finder if a box has a special button attached. In invoicing use F4 

instead of choosing the edit button 

F5    Euro calculator 

F6   Duplicates the cell from above Shift and F6 duplicates and increments the last figure in the cell 

above by one number. In the date field shift and F6 inserts the following days date 

F7    Inserts a row above the current row 

F8    Deletes the current row 

F9    The calculate net button 

F11   Displays window control panel 

F12  Displays the report designer 

b) Monthly and quarterly controls 

Print all the financial reports 
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Report Period   

Trial Balance  Financials, trial, month of period end  

P and L Financials, P and L period from and to 

Balance Sheet Financials, Balance, period from and to 

Prior Year Financials, Prior Yr, period from and to 

Debtors Customer, reports, aged debtors reports, aged debtors analysis 

(summary), change report date as period end and tick to exclude 

later payments 

 

 

Creditors Supplier, reports, aged creditors reports, aged creditors analysis 

(summary), change report date as period end and tick to exclude 

later payments 

Bank Unreconciled Bank highlight bank account, reports, unreconciled transactions 

reports, bank report unreconciled 

Transaction dates – leave from date – change to date as period 

end 

 

See attached checklist and agree balances accordingly 

a) Debtors - ensure it agrees to the TB 

b) Creditors - ensure it agrees to the TB 

c) Payroll - check net wages and PAYE due are correct 

d) Check that the balance on the bank statement less the unreconciled report equals the balance on 

the TB 

e) Agree the petty cash book to sage 
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f) Ensure no transactions are in suspense, if there are journal these to the correct nominal code 

g) Review the debtors and creditors for aged balances or missing invoices 

h) Ensure that the balance sheet balances – nominal codes may have been created which are not 

included within the chart of accounts. 

 

c) Monthly print outs checklists 

 

Monthly Print out Checklist Period………………………... 
 

 

 

 

CUSTOMERREPORTS 
 

Aged Debtors Analysis - Summary / Detailed (fixed) for balances 
 

Check balances agree to debtors control, if not investigate and correct 

 

SUPPLIERSREPORTS 
 

Aged Creditors Analysis – Summary / Detailed (fixed) for balances 

 

Check balances agree to creditors control, if not investigate and correct 

 

PAYROLL 
 

Post / Check PAYE and NIC account balance with weekly and monthly payroll summaries 

 
BANKREPORTS 

 

Reconcile bank balance on the computer to the bank statement 

 

Bank Report -unreconciled 

 

PETTY CASH 
 

Check cash balance to petty cash book and investigate any discrepancies 

 

SUSPENSE 

Review nominal ledger for any unusual balances, i.e. suspense accounts (a/c 9998) and 
misposted items which should be corrected 

 

FINANCIALREPORT 
 

Balance sheet (with underlining) –fixed 

 

Period Trial Balance –fixed 

 

Profit and Loss (with underlining) –fixed 
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Print other reports as required – e.g.: Prior Year, Budgetetc. 

 

VAT 
 

Detailed report (each VAT quarteronly) 
 

Review sales and purchase ledger. Check purchase ledger balances to supplier 
statements.Review debtors for old and/or incorrect balances which may require writeoff 

Check monthly profit and loss figures and ensure they appear reasonable. Investigate 
anyunusual items. Check balance sheet to ensure that “net current asset/liabilities” equals 
“financed by”total 

 

NOMINAL REPORTS 
 

Nominal activity (fixed) by date – each month or annually 
 
 

 

Feedback Sheet 

If you have any comments about this manual, or any other associated queries please let us know. 

You can copy this form and forward it to us or contact us by telephone, fax or email details. 

From 

Company Name………………………………………………………………... 

Contact Name…………………………………………………………………. 

Email or Telephone……………………………………………………………. 

Date……………………………………………………………………………. 

Subject…………………………………………………………………………. 

Comments/Queries 

L O. 2.5 - Producing financial reports 

 Content/ Topic 1. Apply financial module to produce financial report 

Reports are a very important area of the Sage 50 Accounts software. There are a number of places 

where you can access the reports. Each module has its own set of reports. So, if you wanted to see 

your Customer Activity report, you can go into Customers, then click Reports and choose the 

appropriate one.  

Likewise, the Company module has your Balance Sheet Report and Profit and Loss reports. There 

are numerous reports available for each module. To view the reports for each module, from the 

module main toolbar, click Reports. 
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a)Monthly and quarterly controls 

Running the Trial Balance Report 

This report shows the current debit or credit balance for all nominal accounts that have a balance. 

Unused nominal accounts are not listed. Use the Trial button in the Financials window to give you a 

Trial Balance report showing a simple listing of balances held in all of your nominal ledger accounts. 

You can run this report for any month. 

 

Note: This is just a snapshot of the beginning of the report. The report continues beyond the limits 

of this screen shot. 

To access the Trial Balance report 

1. Select Company > Financials. 

2. Click Trial. 

The Print Output window appears. 

3. Select the output you require and click Run. 

The Criteria window appears. 

4. Choose the period that you want to run the report for, and click OK. 

b) Profit and Loss report 

Running the Profit and Loss Report 
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Your Profit and Loss report shows you whether or not your company is trading profitably. You can 

produce a Profit and Loss report for the current month or for any range of consecutive months 

within your current financial year. 

The standard Profit and Loss report shows the balances of each of your income and expenditure 

nominal ledger accounts grouped into categories. These are sub-totalled to show sales, purchases, 

direct expenses and overheads. The amount of gross profit and net profit made is also shown. 

 

 

Note: This is just a snapshot of the beginning of the report. The report continues beyond the limits 

of this screen shot. 

To access the Profit and Loss report 

1. Select Company > Financials. 

2. Click P and L. 

The Print Output window appears. 

3. Select the output you require and click Run. 

The Criteria window appears. 

4. Choose the period that you want to run the report for, and click OK. 

c) Balance sheet 

Running the Balance Sheet Report 
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A Balance Sheet shows what your company owns - your assets, and what it owes – your liabilities. 

For example, motor vehicles or property, bank accounts, debtors, creditors, or cash accounts.  

The difference between the assets and the liabilities is often known as a company's net assets - that 

is, net worth. 

These net assets take the form of capital which is made up of the funds that are financing the 

company's operations. Capital can be made up of several sources of funds such as the capital that 

has been introduced by the owner, share capital, directors' loans and retained funds from each 

year's profit or loss after tax. 

 

Note: This is just a snapshot of the beginning of the report. The report continues beyond the limits 

of this screen shot. 

To access the Balance Sheet report 

1. Select Company > Financials. 

2. Click Balance. 

The Print Output window appears. 

3. Select the output you require and click OK. 

The Criteria window appears. 
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4. Choose the period that you want to run the report for, and click OK. 

d) Prior year 

Running the Prior Year Report 

 This report shows the current values in your sales, purchases, direct expenses and overhead 

account codes in the order and groupings that have been set up in your chart of accounts. 

The report details your trading activities for both the current month, or alternatively the 

period specified, and the year-to-date. 

The previous year's balances for the specified month and year-to-date are shown and compared 

with the actuals to show the amount of difference - that is, variance, between the two. In addition, 

each group total is calculated as a percentage of the total sales figure, as a ratio. 

 

Note: This is just a snapshot of the beginning of the report. The report continues beyond the limits 

of this screen shot. 

To access the Prior Year report 

1. Select Company > Financials. 

2. Click Prior Yr. 

The Print Output window appears. 
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3. Select the output you require and click Run. 

The Criteria window appears. 

4. Choose the period that you want to run the report for, and click OK. 

f) Monthly print outs checklists: 

 Customer report 

As part of the month end procedures the following reports should be printed and filed on a Supplier 

Report file. The reports are stored as favourite’s in Sage. 

The following steps should be followed while producing customer report 

To Run a Customer Report 

1.   From the Customers window, select the Customer(s) required. 

2.   Click Reports. 

The Customer Reports window appears. 

3.   Select (double-click) the folder for the type of report that you want to run (e.g. aged debtors 

reports, day book reports). 

The selected folder opens to display the available reports. 

4.   Select how you want to display your report from the drop-down list. You have the following 

options; Printer, Preview, File or E-mail. 

5.   Click Generate Report. 

Depending on which report you selected, the Additional Criteria window may appear. This includes 

only those criteria that are appropriate to the selected report selected. From here you can select to 

limit the number of transactions you preview. If you select a value in the space provided, only the 

number of transactions specified will be displayed. If you leave the box display as the default value 

0, all of the transactions will be displayed. Click OK to accept the criteria details and run the report. 

 Content/ Topic 2: Apply sage line 50 to generate suppliers report 

a) Suppliers’ report 

To Run a Supplier Report 
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1.   From the Suppliers window, select the supplier(s) required. 

2.   Click Reports. 

The Supplier Reports window appears. 

3.   Select (double-click) the folder for the type of report that you want to run (e.g. aged creditors 

analysis reports, day book reports). 

The selected folder opens to display the available reports. 

4.   Select how you want to display your report from the drop-down list. You have the following 

options; Printer, Preview, File or E-mail. 

5.   Click Generate Report. 

Depending on which report you selected, the Additional Criteria window may appear. This includes 

only those criteria that are appropriate to the selected report selected. From here you can select to 

limit the number of transactions you preview. If you select a value in the space provided, only the 

number of transactions specified will be displayed. If you leave the box display as the default value 

0, all of the transactions will be displayed. Click OK to accept the criteria details and run the report. 

 Content/ Topic 3: Apply sage 50 to prepare a payroll journal 

a) To prepare a payroll Journals 

1.   Choose the Nominal Ledger option from the Sage Line 50 toolbar. 

The Nominal Ledger window opens displaying the Nominal Ledger Chart of Accounts. 

2.   Check that your Nominal Ledger Chart of Accounts includes the net wages, PAYE, national 

insurance and pension nominal accounts codes in the balance sheet section of the layout of accounts. 

3. The default for these nominal account codes are:  

2210 PAYE 

2211 National health Insurance fund with 7.5% calculated on the basic salary 

2220 Net Wages 

2230 Pension with 3% calculated on gross salary minus transport allowance. 

4.   Make a note of the totals from your payroll run for the period to be posted for PAYE, net wages, 

total national insurance contributions (i.e. employer and employee national insurance 
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contributions), employer’s National Insurance contributions, gross wages, any employer and 

employee pension contributions and SSP/SMP reclaimed if applicable. 

1.  Payroll journal format 

 Recall the SALARY.NJR skeleton journal and enter the date of your payroll run. Enter your own 

payroll values into the skeleton journal, as shown below. 

 

 Content/ Topic 4: Apply computerized accounting to generate a bank report 

Bank reports 

To Run your Bank Account Reports 

1.   From the Bank window, select the bank(s) required. 
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2.   Click Reports. 

The Bank Reports window appears. 

3.   Select (double-click) the folder for the type of report that you want to run (e.g. day book 

reports). 

The selected folder opens to display the available reports. 

4.   Select how you want to display your report from the drop-down list. You have the following 

options; Printer, Preview, File or E-mail. 

5.   Click Generate Report. 

Depending on which report you selected, the Additional Criteria window may appear. This includes 

only those criteria that are appropriate to the report selected. From here, you can select to limit 

the number of transactions you preview. Enter a number of transactions you wish to preview in the 

Limit Preview Results box. If you leave the value as 0 all of the transactions will be listed. Click OK to 

accept the criteria details and run the report. 

 Content / Topic 5: Apply computerized accounting  to create a petty cash 

Petty cash 

A petty cash fund is a small amount of cash kept on hand to pay for minor expenses, such as office 

supplies or reimbursements. A petty cash fund will undergo periodic reconciliations, with 

transactions also recorded on the financial statements. There might be a petty cash fund, which can 

be a drawer or box, in each department for larger corporations. 

Create a petty cash account in sage 50 

1. Go to Banking, then click New then Bank Account. 

2. In the Account Type list, click Cash in Hand. 

3. Enter an account name, for example, Cash register. 

4. Click Save. 

 Content / Topic 6: Apply computerized accounting  to produce financial report 

To Run a Financial Report 

1.   From the Sage Line 50 toolbar, click Financials. 

2.   Click Reports. 
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The Financial Reports window appears. 

3.   Select (double-click) the folder for the type of report that you want to run (e.g. audit trail 

reports). 

The selected folder opens to display the available reports. 

4.   Select how you want to display your report from the drop-down list. You have the following 

options; Printer, Preview, File or E-mail. 

5.   Click Generate Report. 

Depending on which report you selected, the Additional Criteria window may appear. This includes 

only those criteria that are appropriate to the selected report selected. From here you can select to 

limit the number of transactions you preview. If you select a value in the space provided, only the 

number of transactions specified will be displayed. If you leave the box display as the default value 

0, all of the transactions will be displayed. Click OK to accept the criteria details and run the report. 

VAT return report  

To Print the VAT Return Reports 

1.   From the Value Added Tax Return window, click Print. 

The Print VAT Return window appears. 

2.   Select the type of report you require from the list displayed. 

3.   To indicate the type of output you require, select the appropriate option button, i.e. Printer, 

Preview, File or E-mail. 

4.   To generate the report, click OK, or to exit the Print VAT Return window click Cancel. 

Nominal report 

To Run a Nominal Ledger Report 

1.   From the main Sage Line 50 toolbar, click Nominal. 

2.   Select from the Nominal Ledger window list box the nominal accounts you wish to report on. 

3.   Select (double-click) the folder for the type of report that you want to run (e.g. day book 

reports). 

The selected folder opens to display the available reports. 
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4.   Select how you want to display your report from the drop-down list. You have the following 

options; Printer, Preview, File or E-mail. 

5.   Click Generate Report. 

Depending on which report you selected, the Additional Criteria window may appear. This includes 

only those criteria that are appropriate to the selected report selected. From here you can select to 

limit the number of transactions you preview. If you select a value in the space provided, only the 

number of transactions specified will be displayed. If you leave the box display as the default value 

0, all of the transactions will be displayed. Click OK to accept the criteria details and run the report. 

L O.2.6 – VAT(Value Added Tax 

 Content/Topic 1:Description of value added tax 

Definition of VAT: VAT is a tax on the consumption of goods and services. It is indirectly paid by the 

final consumer of the goods or service.  

It is the tax on the value added to commodity at each stage of production. It is a consumer 

expenditure tax. It is a tax paid by the final users of taxable goods and services 

Out put VAT 

Output VAT is the value added tax that charged on the sales of goods and services if you are 

registered in the VAT Register.   

Input VAT 

Input VAT is the value added tax added to the price when you purchase goods or services that are 

liable to VAT.   

Calculating VAT 

Exclusive tax  

VAT is said to be exclusive if amount paid for a given product (goods or services) VAT is not included 

in. The tax payer should pay net amount for the product bought plus VAT. 

For example 1; KAMANZI buy the 500 kgs of rice for resale for 100,000 with VAT exclusive. Calculate 

the amount of VAT payable and total amount paid. 

Formula 

 VAT= 
𝐶𝑂𝑆𝑇𝑂𝐹𝐺𝑂𝑂𝐷𝑆𝑋𝑉𝐴𝑇𝑅𝐴𝑇𝐸

100
=   

100,000

100
𝑋 18 =  

1,800,000

100
= 18,000 𝐹𝑅𝑊𝑆 
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Total amount paid= cost of goods or services + VAT payable 

Total amount = 100,000 + 18000= 118,000 FRWS 

VAT is said to be inclusive if amount paid for a given product (goods or services) VAT is included in.  

For example 1; XYZ CO bought the 10000 kgs of beans for resale for 1,000,000 frws with VAT inclusive. 

Calculate the amount of VAT paid. 

 

Formula 

 VAT= 
𝐶𝑂𝑆𝑇𝑂𝐹𝐺𝑂𝑂𝐷𝑆𝑋𝑉𝐴𝑇𝑅𝐴𝑇𝐸

100+𝑉𝐴𝑇𝑟𝑎𝑡𝑒
=   

1,000,000

100+18
𝑋 18 =  

18,000,000

118
= 152,542.37 𝐹𝑅𝑊𝑆 

 

Total amount paid= cost of goods or services + VAT payable 

Total amount = 1,000,000 - 152,542.373 = 118,000 FRWS = 847,457.63 

VAT payable to government 

The amount of value added tax that a taxpayer must remit (concern) to the tax administration in 

the taxation period is the tax payable for the period. The tax is calculated by deducting the input tax 

allowed to the taxpayer from the total output tax payable in respect of taxable goods or services 

supplied or considered as if it was paid by the person in the taxation period. 

VAT refund from the government 

It is possible for the final VAT due of a taxpayer to be negative. In this case, the taxpayer is due a VAT 

refund. There is no further action required of the taxpayer. 

An example of what this may look like on the tax declaration is shown below. 

 

If the VAT refund claimed is a small amount relative to the size of the business, as decided by RRA, 

this will be carried forward and will automatically be used to offset against future VAT payments. 

If the VAT refund claimed is a large amount relative to the size of the business, as decided by RRA, 

RRA will audit the refund and may contact the taxpayer for further evidence. If the refund is correct 

and accurate, RRA will contact the taxpayer and provide a bank cheque for the refund amount. 
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Explain the Rwanda system of Value Added Tax 

The Value added tax system became a source of revenue in Rwanda as a part of tax reform agenda. 

It was introduced in Rwanda in 2001 with a standard rate of 18% on all taxable goods and services. 

All enterprises or companies and individuals are required to register for VAT if their turnover is 

above 20 million Rwf for any period of 12 months or 5 million Rwf in three consecutive months in 

the last quarter of the year (RRA, 2007). The VAT is expected to enhance revenue, improve 

economic efficiency, contribute to deficit reduction effort, and foster growth. Value Added Tax 

(VAT) was introduced in Rwanda in January 2011. VAT is generally designed as tax on final 

consumption of goods and services. They have to apply to the Commissioner General of Rwanda 

Revenue Authority (RRA) and registration is granted. The registered person must collect and 

accounts for VAT. 

Distinguish between taxable Businesses and other businesses 

A taxable business is a business that is reliable to pay tax Business is the activity of making one's 

living or making money by producing or buying and selling products (such as goods and services). 

 Content/ Topic 2: Apply sales order processing to produce sales invoice 

Make out sales invoices including Charges for VAT 

1. From the sage line 50, click sales order processing (SOP) and sales order processing box 

appears 

2. Click new/ edit 

3. Selecting customer account 

4. Selecting item (s) sold, quantity sold  

5. If VAT is exclusive, VAT value is calculated automatically.   

6. But  if VAT is inclusive, click double on vat column and edit item box appears 

7. Click calculates net, then ok. 

8. Save and clause 
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 Content/ Topic 3: Filling VAT return form and declaration form check list 

Fill in a VAT Return form 
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a) Online VAT Declaration form checklist  

 

 

 

L O 2.7 -Storage of information 

 Content/ Topic 1: Discussion on the storage of information 

Data retention policy 

A data retention policy, or records retention policy, is an organization's established protocol for 

retaining information for operational or regulatory compliance needs. 

Master files and reference files 

Master file  

Master file is a collection of records pertaining to one of the main subjects of an information 

system, such as customers, employees, products and vendors. Master files contain descriptive data, 

such as name and address, as well as summary information, such as amount due and year-to-date 

sales. Contrast with transaction file. 

CUSTOMER MASTER RECORD 

  Key Customer account number 

  Key Name 

1. Bill-to address, city, state, zip 

2. Ship-to address, city, state, zip 

3. Credit limit 

https://searchcompliance.techtarget.com/definition/regulatory-compliance
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4. Date of first order 

5. Sales-to-date 

6. Balance due 

 

VENDOR MASTER RECORD 

  Key Vendor account number 

  Key Name 

1. Address, city, state, zip 

2. Terms 

3. Quality rating 

4. Shipping method 

PRODUCT MASTER RECORD 

  Key Product number 

  Key Name 

1. Description 

2. Quantity on hand 

3. Location 

4. Primary vendor 

5. Secondary vendor 

Transitory files 

Transitory files are government records that have short-term use only and do not need to be filed. 

They are produced or received in the course of routine actions, in the preparation of 

other records which replace them, or for convenient reference. 

Transitory records can be in paper or electronic form, including email.  

Examples include:  

Electronic copies of email messages, text and instant messages or other electronic documents 

where one copy has been filed with related records in the office record keeping system. 

 Messages confirming short term arrangements (e.g. taxi ready at 5pm)  

 Alerts and notifications (e.g. check your email; meeting about to start)  

 With compliments (e.g. thanks for taking the time to meet) 

 duplicate copies distributed for reference use, or sent to multiple recipients, where one copy has 

been filed to a recordkeeping system (e.g. copy is filed by the originator of the e-mail, the main 

recipient, or a designated record keeper for a work group and yours is considered duplicate)   

 Routine messages such as notices “to all staff,” requests for meetings, training opportunities, 

news releases, etc. 



 

 

Active and non-active files 

Active files 

Active file is an electronic or hard-copy file containing documents used in the daily operations of an 

organization. An active file contains active records. 

Active records are those in which the person on the record has had some sort of dealings with the 

business fairly recently. For example, if you went to the dentist last week or even a few months 

ago, then your record would be considered active. 

Non active records or files 

Inactive records are documents which are no longer referenced on a regular basis and tend to be 

stored in a less accessible place since they are not used frequently. Many times records become 

inactive when they reach their cut-off as defined on a Records Retention Schedule. 

When you first start your business, your files on customers, suppliers and products might be so 

minimal that you can keep them instantly available and close at hand on your desk. But as your 

company grows and time passes, the amount of paperwork also increases. You must store this 

growing number of paper records in filing cabinets, where you will eventually run out of space. To 

keep current data easily accessible and useful, convert old information to inactive files. 

 

 

 

 
 

 

  



 

 

Learning Unit 3: Understanding the Use of TALLY accounting 

software 

 

L O 3.1 - Introducing tally 

Tally 9 is most popular software for accounts and inventory management. It offers different 

feature for maintaining accounts. Tally 9 is integrated with a lot of advanced feature like better 

data migrating, fast data speed, payroll management, TDS, TCS, job costing and point- of sale 

invoicing etc. 

 Content/Topic 1: The Features in tally 9 

The features of Tally 9 are many. Some of them have been discussed below; 

1. Easy calculation of TDS (Tax Deducted at Source) Using Tally 9 you can calculate TDS 

appropriately. 

2. Negative Stock Warning in Journal Voucher 

Create a stock item with an opening balance of considerable units and pass a delivery note against 

it. using a Journal Voucher to record a sales transaction tracking the delivery note would display a 

warning message of negative stock even through a considerable amount of stock was left over. The 

same has been addressed appropriately in Journal voucher. 

3. Performance in Networking Environment 

Tally 9 can work efficiently in a networking environment, if the Server has Windows XP and Clients 

have Windows 98 as the operating system, Tally performs efficiently with improved data stability. 

4. Interest calculation in Forex 

A Sales transaction created using Forex currency and Interest calculation, calculates the 

Outstanding Forex Interest accurately. 

5. Ledger Account 
Tally now prints the address of the Sundry Debtor/ Creditor ledgers, while printing a ledger 
account. 
 
6. Ratio Analysis 



 

 

If the Net Profit is lesser than the Return on Investment% or Return on Working Capital, Tally 

displays the values with a negative sign. 

 

 

7. Maintain balances bill by bill 

Altering a ledger created under Sundry Debtors or Sundry Creditors, by setting Maintain balances 

bill to Yes affects only the selected ledger and not the Group. 

8. Migration Tool 

Users may now migrate data to Tally 9, using the Tally Data Migration Tool on Tablet PCs and 

Desktop computers of higher processor speed. 

9. Stock Journal 

The value in the rate field of a Stock Journal (Transfer of Materials) appears appropriately. 

10. Purchase/Sales Order 

The list of Party or Customer ledgers is displayed appropriately, while creating a Purchase/ Sales 

order respectively. 

11. Inventory Report 

The Godown – wise Inventory reports mow displays accurate balance values whereas multiple 

Godowns are maintained. 

12. VAT (Value Added Tax) 

You can calculate value added tax in tally 9. 

13. FIFO Perpetual 

Tally introduces a new method of inventory valuation FIFO Perpetual, which is similar to LIGO 

Perpetual. The Normal FIFO treats the opening balance of the financial year as the terminating rate 

to apply for residual stock. FIFO Perpetual takes all existing past data.  

Both LIFO and FIFO Perpetual are capable of changing the valuation when the company is split 

unlike their ‘Annual’ versions, which are consistent. 

14. Payroll 

It has been integrated with accounts, in order to simplify Payroll processing.  

Payroll can be configured to suit the requirements of various types of organization. 

You can now configure, align and automate simple to complex payroll processes. 



 

 

You can print pay slips, maintain salary/ wages and attendance/leave/overtime registers, and 

generate Gratuity and Expat reports. You can also configure Payroll Data with cost centre reports 

for business analysis. 

15. POS Invoicing 

POS Invoicing in Tally is equipped with ease of use and advanced capability to simplify your retail 

operations. It efficiently automates the ‘check – out’ process, and allows youto create invoices and 

collect payments from customers, in a matter of moments. 

16. Multilingual Support 

Tally comes with the World’s First Concurrent Multilingual Business Accounting & Inventory 

Management Software for small and medium businesses. The user interface for the software is 

available in Hindi, Marathi, Gujarati, Bengali, Kannada, Tamil, Telugu, Malayalam, Hinglish 

(colloquial English) and Punjabi, and in Bahasa Melayu and Bahasa Indonesia allowing you to 

interact with Tally, in a language of your choice. 

a) User interface in tally 

The Tally interface displays in the language selected as Initial Startup Language, at the time of 

installation. For example, if you have selected Hindi as Initial Startup Language, the Tally interface 

displays as shown. 

 

b) Company Information 

The first step to get started in Tally, is to Create a Company. The initial screen appears as shown: 



 

 

 

The Gateway of Tally screen is separated into six sections, namely Title Area, Horizontal Button Bar, 

Main Area (Ctrl + M), calculator Area (Ctrl + N), Button Bar and the Bottom Pane. 

The elements of the Gateway of Tally screen are explained below: 

c) Title Area 

Title Area contains the Tally Copyright and Tally website link. You can access the Tally website 

directly from the Tally screen. You must have access to the Internet and Internet Explorer Web 

browser installed on your computer. 

Click on the http://www.tallysolutions.com link on the top frame of the screen to enter our 

website. The link appears in all screen of Tally. 

The Product type (Tally Gold, Tally Sliver, Tally Bronze or Educational) and Tally Serial Number 

appears on the upper-right corner. The software serial number is usually a unique number. 

Horizontal Button Bar 

The Button, Print (Alt + P), Export (Alt + M), Upload (Alt + O), Language (Ctrl + L), Keyboard (Ctrl + K) 

and Help (Alt + H) can be seen in the Horizontal Button Bar. 

Bottom Pane 

The Bottom Pane contains the Version number, Release details (every ti8me a new release of Tally 

is made, it is identified with a different release name like Release 3.14) and the Current Date (the 

date configured in the computer). The name of the day, date, month and year is displayed in DD, 

MM and YYYY format on the right- hand side. 



 

 

System time (the time configured in the computer) appears on the lower-right corner in Hour: 

Seconds: Minutes (HH/MM/SS) format. 

The Pate appears in the lower left corner in the Bottom pane. 

Close Button 

The Close Button in the upper right corner functions similar to the use of ‘Esc’ in Tally. It brings you 

to back to the Gateway of Tally from any screen. 

Minimize Button 

The Minimize button performs the standard Windows Operating System’s function (windows 

95onwords), allowing you to minimize Tally and work on other applications. 

To restore Tally, click on the Tally icon on the taskbar. 

Main Area (Gateway of Tally) 

The Main Area is separated into two: 

1. Left-hand side area 

2. Right-hand side area 

The left-hand side provides information on Current Period, Current Date and List of Selected 

Companies (Name of the company and the date when last entry has been made). 

The right-hand side displays the Company Information menu such as Select a Company, Create a 

Company, Backup a Company or Restore a Company and so on. 

Hot Keys 

Hot keys are capitalized and are red in color on all the menu screens. Using the Hot Keys in the 

Company Info Screen will take you to that particular screen or display the sub – menus within that 

Option. 

Calculator Area 

Press [Ctrl + N] to activate the calculator. Calculator Area is used for calculator functions. Any type 

of independent calculation can also be done using the calculator. 

Button Bar 

The buttons are designed to make the work easier and faster and faster and vary from one screen 

to another based on the screen functionality. They appear on the right hand side so the Tally screen 

and the inactive buttons are greyed out. You can either click these buttons or press the shortcut 

keys to access the relevant screen. 

The following are some of the buttons and their functions: 



 

 

Help (Alt + H) – To access Tally’s online context-sensitive help 

F1: Select Cmp– To select the company from the list of companies and access data from other data 

directories on the local system or through the network. You can also access the Directory field by 

pressing [Backspace]. 

F12: Configure – To access the configuration settings to manage the information entered in Tally. 

For example, you can access the General Configuration to set country specific defaults, before 

creating a company. 

Button where a character or function key is underlined indicates that you have to press underlined 

character or the function key along with [ALT] key. 

Button where a character or function key is double underlined indicates, you have to press the 

character or the function key along with [CTR;] key. 

· F1: Press the shortcut function key [E1] to select a company. 

· F1: Press [ALT +F1] to shut a company 

· F8: Press [CTRL + F8] to select the Credit Note voucher 

· Ctrl + M: Press Ctrl + M to access the Gateway of Tally. 

· Ctrl + N: Press Ctrl + N to access the Calculator/ODBC Server frame. 

Country Specific Configuration 

The options available are Country Details, Style of Names, Style of Dates, 

Configuration  of Numbers and Other Options. 

Go to Gateway of Tally > F12: Configure> General 



 

 

 

The configuration settings of Country Details, Style of Name, Style of Dates and Configuration of 

Numbers are self-explanatory. The prime differences are in the use of terms like VAT in Europe and 

Sales Tax in Asia and American that have to be configured before creating a company. 

 

 Content/ Topic 2:Using tally9 to create a company 

 

CREATING A COMPANY 

Creating a Company involves providing basic information about the company whose books of 

accounts are to maintained in Tally. 

Go to Gateway of Tally > (Alt + F3) Company info. > Create Company 



 

 

 

 

Above is displayed an International Company Creation Screen. Note that the State and PIN Code 

fields are not available. 

The screen for India/SAARC would be: 

 



 

 

Directory 

The data path where you want the company to be created is specified in the Directory field. 

This field is skipped by default when you create the company in the data path given in the Tally.INI 

file. If you want to change it, use the backspace key and modify it to the path require. 

This is referred to as the Tally Anywhere concept – which is the ability to create/load companies in 

separate directories. The Directory field is displayed while selecting Select, Create, Backup, Restore 

and Rewrite options for a company. By default, the cursor will skip the field, presuming that you 

wish to use the default data directory for your work.  

You may press Backspace to give a new path and work from there. 

For example, the default Tally data directory could be C:/TALLY/DATA. You may now wish to create 

a new company on C:/TALLY/PERSONAL, and some other companies on C:/TALLY/BRANCHES. The 

next time, the default directory displays C:/TALLY/DATA, and if you wish to work on the data of 

your branches, press Backspace and enter C:/TALLY/BRANCHES for the directory name. This 

displays the companies whose data is stored in that location in the List of Companies. You can even 

give the path of a network server or any other storage device. 

Name 

Enter the name of the company whose books are being opened. If you are a professional 

accountant and are maintaining the books of your clients, give the Client Company’s name. 

Mailing Name and Address 

In addition to the Company Name, Tally provides the facility to enter the Mailing 

Name field. It displays the Company Name by default. You may change it as required, if the mailing 

name is different form the Company Name, 

 The mailing name and address details are picked up for inclusion in any report that needs the 

company name and address as heading. For example: Balance Sheets, Statement of Accounts, and 

so on. 

Tally’s reports print the mailing name and address as given: 

 

 



 

 

Tally does NOT restrict the number of lines for the address details. Tally accommodates all the 

entered information and vertically compresses the same. 

Note: 

1. In the space provided for the Address details, observe the vertical compression as compared to 

the Mailing Name field where there is horizontal compression. 

2. You can specify any length for the mailing name and you are permitted to give any number of 

lines for the address. The information is completely visible. 

3. Tally handles compressed information correctly while printing. It adjusts the reports accordingly. 

Statutory compliance for 

Select the Country from the List of Countries.  

The Statutory Features and Base Currency Symbol are enabled in accordance with the country 

selected. For example, if the accounts belong to a company in India, the base currency would be 

Indian Rupees. The Base Currency will appear with respect to the Country selected. 

Selecting India from the List of Countries brings up a State, pin code and 

Telephone No. field. 

State 

You can select the appropriate state from the predefined list. 

PIN Code 

Specify the PIN Code (Postal Index Number) of the specified address. 

Telephone 

Enter the Telephone number. 

E-mail Address 

Enter the E-mail address that will be used to e-mail documents, reports and data from Tally. 

Currency 

Currency symbol is the symbol of the base currency, that is, the currency that will be used to 

maintain the books of account. 

The symbol Rs. appears by default for India/SAARC Companies and the field is left blank for 

International Companies. 

Maintain 

Tally displays a drop down for the Type of Company with two options Accounts only and Accounts 

with Inventory. 



 

 

Select Accounts only if you do not have any inventory transactions (suitable for professionals and 

corporate offices). 

However, at a later data (if required) you can choose to alter the information as Accounts–with–

Inventory. Select Accounts– with – Inventory, to maintain both financial accounts and inventory. 

Financial Year From 

In most countries, the books of accounts of a company are maintained for a stipulated period liked, 

12 months, 15 months, and so on. This stipulated period is referred to as the Financial Year. 

The stipulated period of the financial year is 12 months in most countries. Tally automatically 

considers 12 months from the date you give here as the Financial Year. 

For example, if you enter April 1, 2005 as the date, the Financial Year will be from April to March 

ending with March 31, 2006. If you enter October 1, 2005 as the Financial Year From then the 

financial year will be from October 2005 to September 2006 ending with 30th of September every 

year. 

Tally allows you to maintain data for multiple years by changing the period (Alt + F2) at the 

Gateway of Tally. In addition, you can also specify the date of actual establishment of the company 

(date of incorporation ) 

Alter (modify) a company 

You can modify any information at any time that is set while creating a company. 

1. Go to Gateway of Tally 

2. Select F3: Cmp Info. (ALT+F3) from the button bar 

3. Select Alter and press Enter and the screen appears as shown below: 

 

Make the necessary changes in the required fields. To change the password if Use 

Security Control is set to Yes: 



 

 

4. Enter the Name of Administrator. 

5. Enter the new password. 

6. Re-enter the password in the Repeat field to confirm. 

7. Enter the Old Password and Accept the screen to alter the company 

 

DELETE A COMPANY 

To delete a company, you have to load the company first. 

1. Select F3: Cmp Info. (ALT+F3) from the Gateway of Tally to proceed to the 

Company Information menu. 

2. Select Alter and press Enter. 

3. Select the company to be deleted. The Company Alteration screen is displayed. 

4. Use Alt + D to delete. Tally will prompt for a confirmation on deleting the company. 

5. Press enter to delete the company. 

Note: Deletion of a company is irreversible. The company is permanently deleted from the system 

L O 3.2 Managing groups, ledgers and voucher 

 Content/ topic 1. discussion on managing group 

Accounts Info menu lists the masters through which you can provide Tally the details of your 

company’s accounts. You can also manage Groups, Ledger and Vouchers from this menu. 

Go to Gateway of Tally > Accounts Info. 

Tally follows the modern way of managing accounts called ‘Single Ledger’ concept of accounting. 

This is in direct contrast to subsidiary Ledger Accounting. All financial entries are made using 

ledgers or account heads.  

Ledger accounts are created to identify transactions. The single ledger concept avoids the need for 

sub-ledgers and corresponding control accounts in General Ledger. Tally allows you to group ledger 

information to generate meaningful reports that are compliant with laws. Groups in Tally classify 



 

 

and identify account heads according to their nature. This helps in presenting summarized 

information. 

Gateway of Tally > Accounts Info.>Groups 

 



 

 

 

 

a) CLASSIFICATION OF ACCOUNT HEADS 

Usually, grouping of accounts is dome only when reports are needed. This may result in delay in 

preparing the reports. Tally allows you set up chart of accounts. 

You can group the ledger accounts while creating them. Tally will enable your reports and 

statements to reflect the desired classification at any point. In Tally, you can also regroup the 

ledgers (with some minimal restrictions) if re-classification is necessary. Re-grouping becomes 

necessary whenever there is a change in the nature of information, however, regrouping cab be 

done only by users who have authorized rights. 

At the highest level of grouping, accounts are classified are classification into capital or revenue – 

specifically into assets, liabilities, income and expenditure. Based on mercantile accounting 

principles, Tally provides a set of reserved groups and allows you to modify their names or create 

subgroups. 

 

 



 

 

 Content / Topic 2: understanding the concept of sub-group 

Sub-Groups 

A sub-Group behaves exactly like a group and is created under a group. 

a) Concept of Sub-Groups 

Groups have a hierarchical structure. The main group of accounts that determine the entire 

accounting and their presentation are the asset, liability, income or the expenditure. 

The main groups ascertain whether a ledger affects Profit & Loss Account as a revenue item or if it 

affects the Balance Sheet. 

The Reserved Primary Groups and subgroups are: 

Primary Groups of Capital Nature 

1. Capital Account 

b) Reserves and Surplus [Retained Earnings] 

2. Current Assets 

a) Bank Accounts 

b) Cash-in hand 

c) Deposits (Asset) 

d) Loans & Advances (Asset) 

e) Stock-in-hand 

f) Sundry Debtors 

3. Current Liabilities 

a) Duties and Taxes 

b) Provisions 

c) Sundry Creditors 

d) Fixed Assets 

4. Investments 

5. Loans (Liability) 

c) Bank OD Accounts [Bank OCC Accounts] 

a) Secured Loans 

b) Unsecured Loans 

6. Suspense Account 

7. Miscellaneous Expenses (Asset) 

8. Branch/Divisions 



 

 

9. Sales Account 

10. Purchase Accounts 

11. Direct income [Income Direct] 

12. Indirect Income [Income Indirect] 

13. Direct Expenses [Expanses Direct] 

14. Indirect Expenses [Expanse Indirect 

Note: Aliases for the groups are given in square brackets.   

 

 Content / Topic 3 Discussion no Each of the Reserved Groups 

1. CAPITAL ACCOUNT 

This records the Capital and Reserves of the company. The ledgers that belong to 

Capital Accounts are Share Capital, Partners’ Capital A/c, and Proprietor’s Capital Account and so 

on. 

Reserves and Surplus [Retained Earnings] 

This contains ledgers like Capital Reserve, General Reserve, and Reserve for 

Depreciation and so no. 

2. CURRENT ASSETS 

Current Assets record the assets that do not belong to either Bank Accounts or 

Case-in-Hand sub-groups. 

Bank Accounts 

Current account, savings account, short tern deposit accounts and so on. 

Cash-in-hand 

Tally automatically creates Cash A/c in this group. You can open more than one each account if 

necessary. 

Note: An account under Cash-in-hand group or Bank Account/Bank OCC A/c group is printed as 

separate Cash Book in the traditional Cash Book format and does not form part of the Ledger. 

Deposits (Asset) 

Deposits contain Fixed Deposits, Security Deposits or any deposit made by the company (not 

received by the company, which is a liability). 

Loans & Advances (Asset) 



 

 

This records all loans given by the company and advances of a non-trading nature (example: 

advance against salaries) or even for purchase of Fixed Assets. We do not recommend you to open 

advances to Suppliers’ account under this Group. 

Stock-in-hand 

This group contains accounts like Raw Materials, Work-in-Progress and Finished Goods. The balance 

control depends on whether you have selected Integrated Account-cum- Inventory option while 

creating the company. 

Integrated Accounts-cum-Inventory 

This option has a significant effect on the Balance Sheet and Profit & Loss Account. If set to Yes, it 

brings the stock/inventory balance figures from the inventory records and provides a drill down to 

the Stock registers from the Balance Sheet. 

You are not allowed to directly change the closing balance of an account under this group. You are 

allowed to pas transactions in Inventory records and the account balances are automatically 

reflected in the Balance Sheet as Closing Stock. 

Non- Integrated Accounts-cum-Inventory 

If integrated Account-cum-Inventory option is set to No, it ignores the inventory books figures and 

picks up manually entered closing stock balances from the ledger account created.  

This provides the facility to maintain accounts separately and inventory separately. 

You are not allowed to pass transactions if your accounts that come under this Group. It allows you 

to hold opening and closing balance only. Since no vouchers can be passed for these accounts, they 

are the only accounts for which the closing balances can be directly altered (by an authorized user 

only). 

3. CURRENT LIABILITIES 

Accounts like Outstanding Liabilities, Statutory Liabilities and other minor liabilities can be created 

directly under this group. Sub- groups under Current Liabilities are Duties and Taxes, Provisions and 

sundry Creditors 

Duties and Taxes 

Duties and Taxes contain all tax accounts like VAT, MODVAT, Excise, Salas and other trade taxes and 

the total liability (or asset in case of advances paid) and the break-up of individual items. 

Provisions 



 

 

Accounts like Provision for Taxation, Provision for Depreciation and so on are recorded under 

Provisions. 

4. INVESTMENTS 

Group your investment accounts like Investment in Shares, Bonds, Govt. securities, long term Bank 

deposit accounts and so on. This allows you to view the total investments made by the company. 

5. LOANS (LIABILITY) 

Loans that a company has borrowed, typically long-terms loans. 

Bank OD Accounts [Bank OCC Accounts] 

Tally provides you with distinct types of Bank Accounts, 

Bank OCC A/c 

To record the company’s overdraft accounts with banks. For example, Bill 

Discounted A/cs and Hypothecation A/cs etc. 

Note: An account under Bank OCC A/c group is printed as separate Cash Book in the traditional 

Cash Book format and does not form part of the Ledger. 

Secured Loans 

Term loans or other long/medium term loans, which are obtained against security of some asset. 

Tally does not verify the existence of the security. Typical accounts are Debentures, Term Loans, 

and so on. 

Unsecured Loans 

Loans obtained without any security. Example: Loans from Directors/partners or outside parties. 

 

6. SUSPENSE ACCOUNT 

In modern accounting, many large corporations use Suspense Ledger to track the money paid or 

recovered, the nature of which is not yet known. The most common example is money paid for 

Traveling Advance whose details will be known only upon submission of the TA bill. Some 

companies may prefer to open such accounts under Suspense Account. 

Loans and Advances (Asset) group. 

The Suspense Account is a Balance Sheet item. Any expense account even if it has ‘suspense’ in its 

name, it should be opened under Revenue group like Indirect Expenses and not under Suspense 

Account group. 

 



 

 

7.MISCELLANEOUS EXPENSES (ASSET) 

This group is typically used for legal disclosure requirements such as Schedule VI of the Indian 

Companies Act. If should hold incorporation and per-operative expenses. 

Companies would write off a permissible portion of the account every year. A balance remainsto an 

extent that cannot be written off in Profit & Loss Account. Tally does not show loss, carried forward 

in the Profit & Loss Account, under this group. The Profit & Loss Account balance is displayed 

separately in the Balance Sheet. 

8. BRANCH/DIVISIONS 

This maintains ledger accounts of all your company’s branches, divisions, affiliates, sister concerns, 

subsidiaries and so on. Tally permits Sales and Purchase transactions to take place with accounts. 

Just treat them as any other party accounts. If you wish to maintain the books of a branch/division 

on your computer, you must open a separate company. (Tally allows maintenance of multiple 

company accounts). Revenue- Primary Groups 

9. SALES ACCOUNT 

You can classify your sales accounts based on Tax slabs or type of slabs or type of sales. This also 

becomes a simple mechanism for preparation of Tax returns. 

Examples: 

· Domestic Sales 

· Export Sales 

Now under Domestic Sales open the following ledgers: 

· Sales (10%) 

· Sales (5%) 

· Sales (exempt) 

You can even open an account as Sales Returns under the group Domestic Sales to view your net 

sales after returns (or the returns may be directly passed through Journal against the specific Sales 

account). 

10. PURCHASE ACCOUNT 

This is similar to sales accounts, except for the type of transactions. 

11. DIRECT INCOME [INCOME DIRECT] 



 

 

These are Non-trade income accounts that affect Gross Profit. All trade income accounts fall under 

Sales Accounts. You may also user this group for accounts like Servicing, Contract Change that 

follow sales of equipment. 

For a professional services company, you may not use Sales Account group at all. Instead, open 

accounts like Professional Fees under this group. 

12. INDIRECT INCOME [INCOME INDIRECT] 

These are miscellaneous non-sale income accounts. Example: Rent Received and Interest Received. 

13. DIRECT EXPENSES [EXPENSES DIRECT] 

These are manufacturing or direct trading expenses. These accounts determine the Gross Profit of 

the company. 

14. INDIRECT EXPENSES [EXPENSES INDIRECT] 

All administrative, selling or non-direct expenses. 

Profit & Loss Account is a reserved primary account in Tally. You can use this account to pass 

adjustment entries through journal vouchers. For example, transfer of profit or loss account to 

Capital or Reserve account. 

Creating a Group 

You can create multiple or single group from create option. In multiple group creation, the sub-

groups will automatically inherit the characteristics of their parent groups. 

Go to Gateway of Tally > Accounts Info.> Groups > Create (under Single Group) 

The Group Creation screen displays 

Name of Group 

Enter the name of the Group to be created. For example, Administrative Expenses 

 

Alias 

Enter an alias name to allow access to the group using the Alias in addition to its name of leave it 

blank. For example, for Administrative expenses, you can enter Office Expense or even an 

alphanumeric code, say E001, as an alias. 

Under 

Specify under which existing (Parent) group the sub-classification is required. If it is a new primary 

group, select Primary (requirement of a new primary group is very rare, but the option exists). You 

can also create a new Parent Group by using Alt + C. 



 

 

Note: Creation of new Primary Group is not allowed if an Allow Advanced entry in Masters is set to 

No in F12: Configure. 

Additional Information 

If a group (e.g. Printing) is created under Primary, you must select the appropriate option from the 

list whether it is an asset, liability, income or expenses. If you select an income or expenses you 

should specify whether it will affect the gross profits or not by suitably setting the option Does it 

affect Gross Profits? to Yes/No 

You can use this concept when you wish to segregate your profits into Operative Profit and Net 

Profit. This helps you when you want to consider other revenue accounts in addition to Direct 

instead of Gross and Net Profit). Normally, Tally calculates Gross Profit using Opening Stock, 

Purchase Accounts, 

Direct Expenses, Sales Accounts, Direct Incomes and Closing Stock only. To make other accounts 

contribute to this, without classifying under these reserved heads, set this option to 

Yes. 

Group behaves like sub-ledger? 

This option is applicable to Sundry Debtors group, you can set this to Yes to display Sundry Debtors 

without Ledger break-up in statements. Normally, Sundry Debtors will have a large number of 

ledger accounts under it and it can be expanded during display to show ledger balances. To disable 

this detailed display set this option to No. 

Net Debit/Credit Balances for Repotting? 

Setting this option to Yes will display either the net debit or credit balance in the report (whichever 

is higher). If this is set to No, both debit and credit balances will displayed in the report. 

Used for Calculation (e.g. taxes, discounts)? 

Set this option to Yes if ledgers under this group would have percentages for discounts/taxes to be 

used for invoice entry. This gets reflected while passing voucher entry in Invoice mode, it uses the 

automatic calculation capability. 

Displaying and Altering Group 

You can display and alter the Group in Single mode or multiple mode. 

Displaying a Single Group 

Go to Gateway of Tally > Accounts Info. > Group > Display (under Single Group) 

Select the name of the Group from the List of Items. You cannot make any changes in Display 

mode. 



 

 

Altering a Single Group 

Go to Gateway of Tally > Accounts Info. > Group > Alter (under Single Group) 

Select the Group that you wish to alter from the List of Groups. Make the necessary changes and 

click Yes to save the changes. 

 Content / Topic 4 : Apply tally 9 to display a multiple group 

 

a. Displaying Multiple Groups 

Go to Gateway of Tally > Accounts Info. > Group > Display (under Multiple 

Group) Select the Group from the List of Groups to display all the Groups under the selected Group 

or select All Items to display all Groups. The Multi Group Display screen lists 

Groups and the corresponding details of the Groups. 

b. Altering Multiple Group 

Go to Gateway of Tally > Accounts Info. > Group > Alter (under Multiple Group) 

Select the Group for which you want to alter from the List of Groups. In Multi 

Group Alteration screen, make the necessary changes and click Yes to save changes. 

c. Deleting a Group 

Gateway of Tally > Accounts Info > Groups > Single/Alter 

The Delete function is performed through the single alteration mode. You cannot delete groups 

form the Multiple Alteration mode. 

1. Select the group to be deleted. 

2. Press Alt + D to delete. 

Note: You cannot delete a group if it is a reserved group or a group has sub-groups or ledgers in it. 

Note: A new group created under primary will not reflect in reports until you pass masters/ 

transactions for that group. 

 

 

 Content/ Topic 5: Apply tally 9 to produce ledger accounts 

a) Introduction to Ledgers 

A Ledger is the actual account head to which you identify a transaction. In Tally, you pass all 

accounting vouchers using Ledgers. However, all Ledgers have to be classified into Groups. Hence a 

thorough understanding of account classifications is important for working with Ledgers. to 

Gateway of Tally > Accounts Info. > Ledgers 



 

 

b) Creating a Ledger 

Ledgers can be created in single and multiple modes. In multiple mode you can create multiple 

ledgers at a time. 

c) Creating a Single Ledger 

The creation of Ledger depends on the features you opt for in the F11: Configure screen before 

creating any Ledgers. You may configure or set your Ledgers to enable or disable advanced mode. 

Tally automatically creates two Ledger accounts namely, Cash (Under Cash-in- Hand) and Profit and 

Loss Account (direct Primary Account). You need to create all other accounts heads. There are no 

restrictions in Ledger creation except that you cannot create another Profit & Loss A/C. Any number 

of Cash Accounts may be created in any other name like Petty Cash. 

d) Creating a Ledger Accounts with minimal information: 

Go to Gateway of Tally > Accounts Info. > Ledgers > Create (under Single Ledger) 

Name 

Enter the Name of the account. You can provide the full name of the account. 

Tally fits it all in. Press Enter to move to the next field. Tally does not allow entry of duplicate 

names. The uniqueness check is made here itself. Note that punctuation and other non-relevant 

information are ignored by Tally in its recognition of a name. Thus, CST, C.S.T. and C.S.T. are all 

considered as same. 

Tally converts the first letter of all relevant words to upper case, which helps you; speed up data 

entry. You need not bother about changing the case every time it is a different word. 

Alias 

Enter an alias name if required. You can access the Ledgers using the original name or the alias 

name. 

Under 

All accounts must be classified under their appropriate Groups. Select the Group under which the 

Ledger is created from the List of Groups. To create a new Group from this field press [ALT+C] 

A Group is not important by itself, but because it controls the usage of Ledger accounts.  

A wrong classification would affect the treatment of the Ledger account in final statements and 

during voucher entry. 

You can, alter a Ledger account to change its group classification at any time. 

Opening Balance 



 

 

If yours is an existing company whose books you are entering onto Tally, Opening Balance would be 

applicable in circumstances such as when the Ledger is an asset or a liability and if it has a balance 

in the account as on the date of beginning of books in Tally. Tally recognizes normal accounting 

principles of debit balances for Assets and credit balances for Liabilities. It accepts the reverse for 

obverse balances. Revenue accounts normally do not have balances. Tally, however, permits you to 

give balances even for such accounts – You may be transferring your books on to Tally in the middle 

of the year and may not have closed them in your earlier system. Hence, you may specify whether 

the balance is Debit or Credit. Simply D or C also would suffice. 

Note: Use Ctrl + A at the field following which the information in other fields do not need to be 

changed. 

 Content / Topic 6 :apply tally to create multiple ledgers 

a) Creating Multiple Ledgers 

You can create multiple Ledgers at a time in this mode. You can first create a Ledger under each 

group in single Ledger mode and then the rest of the Ledgers in multiple mode. Tally will set the 

settings of the Ledger created as default for other Ledger to be created in multiple mode. 

Go to Gateway of Tally > Accounts Info. > Ledgers > Create (under Multiple Ledger) 

 

The Multiple Ledger Creation screen is displayed. A brief description on each of the fields in the 

Multiple Ledger Creation screen follows: 

b) Under Group 

Select the name of the group under which you want to create the Ledgers from the List of Groups. 

Below this field, the other fields are arranged in a table. The cursor rests at the field Name of 

Ledger. 

The other fields in the column are: 

S. No 

This is auto generated. 



 

 

Name of Ledger 

Enter the name of the Ledger 

Under 

This field defaults to the parent group selected in Under Group. The selected group in Under Group 

gets displayed here automatically and the cursor skips this column. 

However, if you select All Items in Under Group field, the cursor does not skip this column and you 

have the option to select the group.  

You can even create a new group from this field by pressing Alt+C. 

c) Opening Balance 

This is the balance remaining when you first enter your books on Tally, i.e., the date of beginning of 

books. If you have opted to maintain balances bill-by-bill, you must givethe bill details. 

Dr 

Specify whether the Opening Balance is Debit or Credit. Tally follows the normal accounting 

principles of accounting. 

Note: While creating Ledgers in multiple mode, the field Cost Centers are applicable, is set to Yes 

for Revenue accounts and No for Non-Revenue accounts by default. 

The field Inventory values are affected is set to Yes for Sales and Purchase Accounts and No for the 

others by default. 

 Content / Topic 7:Description of the method of calculation of tax 

a) Method of Calculation 
There are four methods of calculating a duty. 

1. Duty Based on Items – Tax based on Item Rate 

2. Additional Duty 

3. On Total Sales 

4. Surcharge on Tax 

Tax or Duty Based on Items Rate (or Excise Duty) This type of account is suitable in cases where 

there are differential rates of duty/tax on items. In India, excise duty accounts would normally 

adopt this method. In the UK, VAT accounts would do likewise. When creating your Inventory item 

masters, you might specify Rate of Duty for each item. In your account books, you would open a 

ledger for the duty, possibly by the name VAT 17.5%or Excise Duty 12.5%. You will select this 

method to instruct Tally to pick up the Rate of Duty specified in your Inventory item master during 

master during invoice entry. If one or more items exist with the same rate of duty, then the amount 



 

 

is calculated using the total. Otherwise, it is calculated on total sales. For example, Your invoice 

lists, 

Item A (Rate 10%) for 10000/- 

Item B (Rate 12%) for 15000/- 

Item c (Rate 10%) for 18000/- 

Duty (VAT or Excise) will be calculated as follows: 

 

 

b) Additional Duty 

When excise duty is not enabled for invoicing purposes in Company Features [F11] (as applicable 

for many products in India), Additional Duty and Surcharge function alike. 

In case it is enabled, then Additional Duty is added to the ‘Duty Based on Items’ in the invoice to 

reflect the ‘Table Duty payable’. Its method of calculation is explained under ‘Surcharge’. 

On Total Sales 

As the type suggests, duty will be calculated on the total of individual values of the items. It does 

not consider the Rate of Duty specified for each item in your inventory masters. 

It does not calculate duty on the current sub-total unless you have specifically opted for it in the 

company features. Hence, the two scenarios could be as follows: 

When you have not opted for calculation on current sub-total: 

Assuming that there are two items in the invoice: 

Item A 10000/- 

Item B 15000/- 

Tax 2% will be calculated at 2% on total sales of 25000/- = 500/- tax amount following which you 

obtain a current sub-total of 25500/-. 

If you now add another line, Tax 4%, it will calculate 4% also on 25000/- (on total sales) giving 

another 1000/- as tax. 

If you opt for calculating on current sub-total: 

The above Tax 4% will be calculated on 25500/- (25000+500) giving 1020/-. 

c) Surcharge on Tax 



 

 

Surcharge and Additional Duty are charged on the immediately preceding entry. A surcharge is 

treated as a percentage of the duty levied. Tally expects the preceding line in the invoice to be the 

duty on which surcharge is to be calculated. 

Hence, in the above example if you have added a line Surcharge 10% it will appear as: 

Item A 10000/- 

Item B 15000/- 

 25000/- 

Tax 2% 500/- 

Charges 10% 50/- (10% of 500) 

Addl. Charge 8%  4/- (8% of 50) 

 

During invoice creation, this figure is used to calculate tax amount based on the method of 

calculation as well as specified in invoicing configuration ([F12] configure > Invoice Entry > Calculate 

tax on current sub-total?). 

Though invoicing has been discussed separately in greater detail, we shall touch upon relevant 

aspects here. 

d) Calculate tax on current sub-total: (Yes/No) 

Tax here refers to VAT or sales tax. During voucher entry in Invoicing mode, you may enter 

additional ledger accounts after giving the list of items in the invoice. Typically, the ledgers would 

pertain to duties, taxes, delivery charges, other charges and discounts. Sales Tax may be calculated 

on the total of item values, viz., Inventory sub-total, or you may specify it to calculate on the 

immediately preceding sub- total. In the latter case, the immediately preceding sub-total could 

include any entry that you may have passed, e.g. Delivery Charges. Tally does not make any 

presumptions and would not verify its appropriateness or otherwise. 

Normally, you would not answer Yes to this option. The facility of Surcharge being available, the 

need to calculate on current sub-total is fulfilled by it. Hence, use it sparingly, maybe only when you 

have both Excise Duty and Sales Tax (on Excise Duty) applicable on an. 

e) Display or Alter a Ledger Account 



 

 

Information in display and alter is the same, hence only alter is discussed. Display option does not 

permit any modification. Alter option is accessible only to authorized users. 

Gateway of Tally > Accounts Info.>Ledgers > Single Alter > select ledger 

 

You are allowed to alter any information of the ledger master with the exception of the Closing 

Balance of a ledger account, if any, other than closing balance of accounts under the group ‘stock –

in-hand’. 

Deleting a ledger account 

You can delete a ledger from the alteration mode by pressing <Alt>+<D>. Tally does not allow 

deletion of accounts that have transactions. Therefore, should you wish to delete an account, which 

has transactions, you must first delete all its voucher entries. 

 Content / Topic 8 :Description of interest calculation using tally 9 

a) Interest Calculations 

Tally allows you to obtain reports on interest calculated by Tally based on the instructions you 

furnish. Interest figures are typically desired in the following situations: 

1. On outstanding balance amounts 

2. On outstanding bills/invoices/transactions (Received and payable) 

Tally gives you an exhaustive capability to obtain interest implications on both. 

b) Activate Interest Calculations 



 

 

Interest is a legitimate return on money invested and chargeable in the business world on loans and 

also on delayed payments. Interest can be calculated on the basis of Simple or Compound Interest. 

Tally allows you to obtain reports on interest calculated based on the instructions you furnish. 

Interest figures are typically desired in the following situations: 

· On Outstanding Balance amounts. 

· On Outstanding Bills/Invoices /Transactions (Receivables and Payables) 

The Activate Interest Calculation field is displayed in the Ledger Creation screen only if Activate 

Interest Calculations is set to Yes in F11: Features. 

Set this field to Yes for each specific ledger account for which interest is to be calculated. 

c) Simple Mode (Where advanced parameters are not applicable) 

To calculate Interest in the Simple Mode: 

1. Go to Gateway of Tally > F11: Features > Set Activate Interest Calculation to Yes.>Set Use 

Advanced Parameters to No. 

2. In the Ledger Creation screen set Activate Interest Calculation to Yes. 

3. The Interest Parameters sub screen is displayed. Enter the Rate and select the interest style from 

the list. 

d) Interest calculations on outstanding balances 

Enter Interest details in Vouchers (only in case of transaction by transaction/Billby- bill). View 

Interest reports. 

You will have to alter existing ledger accounts to permit interest calculations on them. The same 

operation will apply when creating a new ledger account. 

Interest calculation on outstanding balances is allowed for any ledger account. 

You simply specify the interest rate and style of calculation. Nothing is required to be done for 

interest during voucher entry. 

Let’s take an example: Interest calculated on Outstanding Balances 

1. Go to Gateway of Tally> Accounts Info.> Ledgers> Alter (Single)> Bank Ltd 

(Bank account) 

2. Set Activate4 interest Calculation to Yes. 

3. On activation, the Interest Parameters must be set. It is the basis on which interest will be 

calculated for this Ledger account. 

4. Rate: This is the rate at which the interest has to be calculated. In this case, specify 15%. 

5. Interest Style: It is the basis on which the rate is applied. Of the four options, select 365-Day Year. 



 

 

6. Accept the screen. 

You can now view the amount of interest that could be charged by the Bank. 

d) Report on Interest Calculated on outstanding balances. 

The Interest Calculations Report can be displayed and printed. 

Go to Gateway of Tally> Display> Statements of Accounts> Interest 

Calculations> Ledger> Bank Account 

e) Interest calculation transaction by transaction 

Activate and specify interest calculations in ledger masters. 

Transaction by transaction or Bill-by-bill interest calculation is permitted for 

‘Party’ accounts like accounts falling under the groups Sundry Debtors and Sundry Creditors. 

For example: 

1. Alter a Customer account (under the group Sundry Debtors or one of its subgroups). 

2. Set Activate Interest Calculation to Yes. In the Interest Parameters now you have three lines to 

answer. 

3. Set Calculate Interest Transaction-by-transaction to Yes. 

4. Set Over-ride Parameters for each transaction to No. 

If set to No, you are not allowed to change interest parameters in voucher/invoice entry. If set to 

Yes, you can change the interest parameters during entry. 

f) Voucher Entry for booking Interest 

1. Go to Gateway of Tally> Accounting Voucher> Voucher Entry 

2. Select F7: Journal > Debit Note 

3. A Cost Centre Class is also selected if required. Marketing Expenses Class has been selected here. 

4. There are two situations for interest adjustment:- 

Billwise interest 

· Simple Interest – Interest amounts are not debited onto the same bills. 

Create a fresh reference for it. 

· Compound Interest – Amounts are auto-debited to the selected bills. Billwise details will not 

appear in this case. 

5. Interest on balances only 

Bill-wise interest entry 

Debit CP Ltd 

Credit Interest Received 



 

 

When you debit the party account, a list of bills for which interest is applicable pops up. Select the 

bills to adjust. Note that even cleared bills appear. 

Select the respective interest bills from the list. The debit amount is filled up with the total. Select 

New Ref in the bill-wise allocations. In the interest sub-screen, ensure that the rate of interest is 0. 

Now Credit Interest Received. The amount is already filled in. 

Your voucher will resemble the one below: 

 

 

Entries for compound interest are exactly the same as for Simple Interest where all you do is select 

the Voucher Class Compound Interest. Also the Bill-wise details popup subscreen does not come up 

as the amounts are added onto the bills. 

Select Demo from the list and complete a Debit Note. 

Now display Outstanding for CP Ltd 

Note the contents: 

The Bill reference Demo/28/01 and Demo/31/01d are invoices onto which interest has been 

compounded. 

A new Reference no 2 has been created for Simple Interest due from CP Ltd. 

f) Entries for Interest on Balances only 

Again, the issues are Simple and Compound Interest 

Compound Interest 



 

 

Make the following entries in a Debit note with Compound Interest. Voucher 

Class Debit Bank Ltd the amount is automatically filled up with the calculated interest 

Credit Interest Received 

And nothing needs to be dome! The Bank Account has been increased by the amount of inte4rest 

due and the Income account of Interest Received also credited. 

Simple Interest 

Make the same entry as above. 

However, since it has the effect of increasing the Bank Ltd account with the amount due 

(compound effect), you must make a journal entry to reverse it. The reversal entry would be 

something like this: 

Debit Interest Receivable (a current asset account)  

Credit Bank Ltd 

Use a normal Journal voucher for this entry. 

We have to necessary go this route to take advantage of the auto filling of the interest amount 

which can appear only when we use the Bank Ltd account in Debit Note in the first place. 

 Content / Topic 9 : apply tally 9 to produce interest report 

a) Interest Calculation Reports 

Interest Calculation report are automatically produced if the feature is activated In 

F11: Features and the parameters are set for individual ledger accounts. 

There are two types of reports, one pertaining to interest on balances of accounts like loans, and 

the other interest on overdue invoices. 

Interest reports are available for individual ledger accounts as well as for Groups 

b) Interest Calculation on Ledger Balances (e.g. Loans) 

You can get a report on the Ledger balances for the interest calculated. 

Go to Gateway of Tally> Display> Statements of Accounts> Interest 

Calculations> Ledger 

c) Select Account E.g. Bank Loan Account. 

Interest is re-calculated with every change in balance outstanding. The Cr in the interest amount 

should not be confused to resemble an Income. It only means that it is payable and is a Liability. 

To ease interest recording, Tally has an interest template, a special voucher class in Debit Note and 

Credit Notes. 

d) Specifying Closing Stock Values 



 

 

Closing stock values have to be specified when accounts and inventory are not integrated. Tally 

allows you to specify closing stock values even if your books are integrated. It would simply ignore 

the specified figure so long as you maintain the integration. If and when you select to separate the 

books, the specified values would automatically be considered. 

To enter the closing stock as on a specific date, you must alter the ledger account. 

Simply follow the ledger alteration procedure or go from the Balance Sheet via Current Assets. 

Go to Gateway of Tally> Balance Sheet> Current Assets> Group Summary 

(Or) 

Go to Gateway of Tally> Accounts Info.> Ledgers> Alter (Single) 

Assuming that you had a ledger account ‘Stock’ under the group Stock-in-hand the information 

would be as follows 

 

You are allowed to alter the opening balance as well as specify/alter closing balances on different 

dates. You would typically specify Balance Sheet dates so that the Balance Sheet reflects the 

amount of that date. 

 Content/ Topic 10 : apply tally 9 to display and altering legers 

Displaying and Altering Ledgers can be done in Single mode and Multiple mode. The Multiple mode 

allows you to display and alter multiple Ledgers at a time. 



 

 

a) Displaying and Altering a Single Ledger 

You can view the details of the Ledger Masters in Display mode. Display does not permit any 

modification. However you can make changed to Ledger Masters in Alter mode. 

 

b) Displaying a Single Ledger 

Go to Gateway of Tally> Accounts Info.> Ledgers> Display (under Single Ledger.) Select the Ledger 

from the List of Ledgers. The Ledger Display screen in displayed. You will be able to view the details 

of the selected Ledger Master. 

c) Altering a Single Ledger 

Select the Ledger from the List of Ledgers. The Ledgers Alteration screen is displayed. 

You are allowed to alter any information. Make the necessary changes and Accept 

Yes to save. 

d) Specifying Closing Stock Values of a Ledger account the group Stock in Hand 

This is possible only in Ledger alteration mode. Closing stock values have to be specified when 

accounts and inventory are not integrated. Tally allows you to specify closing stock values even if 

your books are integrated. It would simply ignore the specified figure so long as you maintain the 

integration. If and when you select to separate the books, the specified values would automatically 

be considered. 

To enter the closing stock as on a specific date, you must alter the ledger account. 

Simply follow the ledger alteration procedure or go from the Balance Sheet via Current Assets. 

Go to Gateway of Tally > Balance Sheet> Current Assets> Group Summary 

Assuming that you had a ledger account Stock under the group Stock-in-hand the information 

would be as follows: 



 

 

 

You are allowed to alter the opening balance as well as specify closing balances on different dates. 

You would typically specify Balance Sheet dates so that the Balance Sheet reflects the amount of 

that date. 

e) DELETING SINGLE LEDGER 

You can delete a Ledger account from the Ledger Alteration screen by pressing ATL+D Tally does 

not allow deletion of accounts that have transactions. Therefore, should you wish to delete an 

account, which has transactions, you must first delete all its voucher entries. 



 

 

 

 

 Content/ Topic 11: Apply tally for displaying and altering multiple ledgers 

a) DISPLAYING MULTIPLE LEDGERS 

Go to Gateway of Tally> Accounts Info.> Ledgers> Display (under Multiple Ledger. 

Select All Items from the List of Groups to view the details of all the Ledgers in Tally. If you want to 

view the details of all the Ledgers created under a Group select the Group from the List of Groups. 

The Multiple Ledger Display screen is displayed. 

b) Altering Ledgers in Multiple Mode 

Go to Gateway of Tally> Accounts Info.> Ledgers> Alter (under Multiple 

Ledger.) 

Select any Group or All Items from the List of Groups. The Multi Ledger 

Alteration screen is displayed. Make the necessary changes and Accept Yes to save. 

Note: You are not allowed to delete a ledger from this mode. Select single alter mode to delete. 

c) Explanation on Buttons 

F3: Company: To work with a different company. In the creation mode, you can create cost 

categories in the other company. In alter mode, you can copy the information by accepting the 

screen (<enter> or <Ctrl>+<A>). The old company’s information remains. Not available in Display 

mode. 



 

 

F3: New Cmp: To work on the same report of another company. Available only in display mode. 

F4: Parent: To move the cursor to the field ‘Under Group’ 

F4: New Parent: To bring up the list of Groups to select a new parent Group. 

Zero Op Bal: To nullify (change to zero) all opening balances in this group. 

F6: Skip names: For faster data entry when you do not need to the names of ledgers. The cursor 

will not go to that column ‘Under’. Toggle to ‘Edit Parent’. 

F7: Skip Parent: For faster data entry when you do not need to alter the parent Group. The cursor 

will not go to the column ‘Under’. Toggle to ‘Edit Parent’. 

F8: Skip Details: the cursor will not go to the columns Opening Balance and Dr/Cr. Toggle to ‘Edit 

Details’. 

F9: Show Closing: Closing Balances replace Opening Balances. This is available only in alter mode. 

Closing balance is not alterable and the cursor skips the field. 

F10: Chg Sort: To display a column of sorting position indices. Toggle to 

‘Skip Sort’. You may change display positions of ledger accounts under the group. 

Groups, Ledger, Cost Categories, and Cost Centres: To enable you to switch to these areas without 

having to quit from the current screen. 

Voucher 

 Content/ Topic 12 : Preparing a voucher in tally 9 

a) Introduction  

A voucher is the primary document for recording transactions. Transactions recording and analysis 

are greatly facilitated by having specific formats for different types of transactions. Tally provides 

16 different predefined voucher formats or what it calls predefined types of vouchers. These are 

used for recording various transactions.  

 A payment voucher is used for all types of payments, 

  A receipt voucher for all types of money receipts,  

 A sales voucher for recording sales transactions, and so on. 

These predefined vouchers fulfill your normal transaction needs. They pertain to both accounting 

and inventory. Some of these vouchers can also be used differently according to the situation, e.g., 

sales vouchers can be used as invoices, vouchers can be post-dated, etc.  

Such use can be decided at the time of voucher entry by selecting the appropriate button. 

The predefined voucher types can be displayed as follows: 

Gateway of Tally> Display> List of Accounts><Ctrl>+<V> [Voucher Types] 



 

 

 

Tally acknowledges the special requirements of some users for more voucher types. These arise in 

cases like when you need the same voucher but in different names or separate series of numbers. 

Examples include Cash Payment Vouchers and Bank Payment vouchers where the relevant 

predefined voucher is Payment Voucher.  

You may have two or more sets of Sales Vouchers for different kinds of also transactions e.g. Credit 

Sales, Cash Sales, etc. 

You would need to alter a voucher type to change default setting for different information 

appearing in vouchers. Using F12: Configure, you can further configure a voucher. 

b) ALTER A PREDEFINED VOUCHER TYPE 

Even if you do not need extra voucher types, you would normally alter the predefined voucher 

types to customize them according to your needs, e.g., to control their numbers. 

Display or alter each voucher type (by pressing enter or double clicking) after Gateway of Tally> 

Display> List of Accounts>Ctrl+V Voucher Types We shall create a new voucher type to explain the 

different features. It would alsobe applicable to alteration of voucher types including predefined 

types. 

c) CREATING A VOUCHER TYPE 



 

 

Go to Gateway of Tally> Accounts Info.>Voucher Type> Create 

Note: A new voucher type must assume the functions of a predefined voucher type 

The Voucher Type creation screen is divided into three sections depending on the various setting. 

 

Name 

Give the name of the new voucher type, e.g., Sales Invoice. 

General 

d) Type of Voucher 

The type of voucher should be any one of the predefined voucher types (already listed in 

introduction). The new voucher type would inherit the properties of this predefined voucher type. 

It would function exactly like the predefined voucher. 

Abbreviation 

An abbreviation is required particularly for unformatted reports, which do not use compressing 

techniques. (Tally allows printing of both formatted and unformatted reports).Event if the 

Abbreviation is not specified, Tally automatically sets a default name to the Voucher. 

 In this example, give ‘Purch’ as the abbreviation. Though there is no restriction on the length of the 

abbreviation, it should preferably be five characters or less. 

e) Method of Voucher Numbering 

This is, perhaps, one reason for your opting for a new voucher type. There are three methods 

available: 

None 

This will disable numbering of such vouchers. If you select this method, no further information is 

required. 



 

 

 

Manual 

This method will allow you to number vouchers of this type yourself. It does not check for sequence 

of the numbers and permits you to specify anything you wish in the voucher number field. 

However, you may choose to prevent entry of duplicate numbers. If you do, enable the next field 

‘Prevent Duplicates’. 

1. Prevention of Duplicates is possible if you enable the option at the time of creation. You 

may enable it later (by alteration) only if there are no transactions of this voucher type. 

2. If you face difficulty because transactions now exist, simple create another voucher type for 

preventing duplicates of subsequent voucher number 

No further information is required for manual numbering method. 

Automatic 

This method is both flexible and exhaustive. Use it carefully to give you your desired numbering 

system. Select this option to let Tally number the vouchers automatically for you. 

Use Advance Configuration 

If the Method of Voucher Numbering is set to Automatic, then an additional field to set the 

advanced configuration for the Voucher type appears. Setting this field to Yes, Voucher Type 

Creation (Secondary) screen appears. 

A further discussion on these options is necessary. 

f) Use EFFECTIVE dates for vouchers? 

Select Yes if you want to enter effective dates for vouchers. You would opt for this if you have 

instances where a transition under consideration for overdue/ageing analysis is recorded currently 

but will take effect from another date. If effective date is entered, the overdue/ageing will be 

considered from the effective date and not from voucher date. 

Make Optional as Default 

Setting this option to Yes, will set your Voucher to Optional Voucher by default. 

g) Use common narration 

Select Yes to give a common narration for the entire voucher. Tally vouchers can have multiple 

entries. Hence, you may wish to give a common narration for all the entries of the voucher or a 

separate narration for each entry or both. Select Yes even when you want both. 

Select No if you do not want a common narration. 

Example of common narration in a voucher: 



 

 

 

Narrations for each entry 

Select Yes if you want to give a separate narration for each entry of a voucher. 

This would be applicable for a multiple entry voucher where you want separate details for each 

entry. Select Not if you do not want separate narration for each entry. 

 

Note: The option to create an Excise Voucher type appears in the General section if, the Excise 

feature is enabled in F11 features. 

 

 



 

 

 

 Content/ Topic 13: PRINTING a voucher 

Print after saving voucher 

If you want to print every voucher after entering it, select Yes, else select No. This is suitable for an 

online environment where you use the Tally printed voucher as the formal voucher. Remember, 

however, that the transaction is already recorded and posted and should you wish to make 

corrections to the printed voucher, you must alter the Tally voucher online and print it out again. 

Note: Depending on the Type of Voucher you have selected to create or alter, different printing 

features appear in this field. 

Name of Class 

You can create classes by entering the class name in this section 

If the Method of Voucher Numbering is set to Automatic, then and additional field to set the 

advanced configuration for the Voucher type appears. Setting this field to Yes, 

Voucher Type Creation (Secondary) screen appears. 

 

Starting number 

Give the number for the first voucher. Usually it is 1. You can set it to any number you want. Tally 

will auto-increment from this number for subsequent vouchers. However, the numbering of 

vouchers also depends on other variables supplied by you, which follow hereafter. 

Width of Numerical Part 



 

 

You may leave it blanks to let Tally automatically adjust the width according to the number. 

However, for more aesthetically aligned look in reports, you may keep a fixed width, 

e.g., 3. 

Prefill with ZERO? 

When the width is specified, the digits before the number is blank if ‘No’ and zeroes if ‘Yes’ 

E.g. 001 1 

O10 10 

PEU/001/06-07 

PEU/1/06/07 

PEU/1/06/07 

Restart Numbering 

Voucher Numbering may be restarted with the starting number (as specified) at intervals selected 

by you- Daily, Monthly, Never, Weekly or Yearly. You must give the date whence numbering should 

restart under the field Application from. The date must be the first day of the month. You may 

specify more than one Restart dates. For example, should you wish to renumber your vouchers 

form o1 June 06 on yearly basis, you must specify it in the next field. This would retain the 

numbering system in the period. If, however, you want to change the numbers from the beginning 

from monthly to yearly basis, simple alter the first field itself. 

Prefix Details 

If you want the voucher numbers to be prefixed with some fixed information, give the information 

here. Examples of prefix details are: 

1. Month of the voucher as given above-‘April/’ 

2. Company info like ‘TSPL/’ 

3. Even fixed number series like ’1000’ 

Note: The numeric portion begins immediately after the prefix information. 

Therefore, be sure to give a space or a slash ’/’ or some such character should you want a 

separation, e.g. we have specified April/. The slash would cause the voucher number to appear as 

April/001. Other-wish it would be April001. This facilitates simple usage for fixed number series 

appearing as 200100001 where 2001 is the prefix, and 00001 is the starting number with a width of 

5, and with leading zeros. 

 

 



 

 

 

 

 Content/ Topic 14 :Discussion on voucher classes 

VOUCHER CLASSES 

Voucher Classes are available for all major voucher types and the Cost Centres can be allocated if 

classes are used. Automation of cost centre allocation has met the need of “percentage allocation” 

based on predefined figures. Cost centre classes affect all voucher types. 

Voucher Classes for Payment, Receipt and Contra Vouchers 

The primary intention of using classes for payment, receipt and contra vouchers is to enable data 

input in ‘single entry’ or list rather than in Tally’s traditional double entry mode. 

You can also use it to have a separate from for each cash and bank account. 

Let us take an example of a Payment Voucher. You can either alter the existing Payment Voucher 

Type or create a new voucher type based on it. 

(From Gateway of Tally> Account Info> Voucher Types) 

The item Name of Class is below Effective Dates for Voucher and above the Numbering Table. 

Give a name to the class by simply typing it, e.g. Barclays Band Payment. You may create more than 

one class. Hence, you might want to have one more for Cash Payment. 

The Class Table 

Exclude these Groups 

Groups other than Bank or Cash groups should not be selected. This is used to exclude Cash or Bank 

Groups that are not to be used in this class to pay out the money. In out example, we want to 

exclude Cash and Credit Cards. 

Exclude these Groups 

Groups other than Bank or Cash groups should not be selected. You might exclude a top level group 

but include its sub-group. 

Ledger Name 

Selecting the ledger account that will be used to pay out the money will eliminate the need to 

select it during entry. In title case, it is Bare Slays Bank. In a receipt voucher, you will select the 

ledger account into which monies will be received. You may even select ‘Not Applicable ‘. The 

purpose of selecting ‘Not Applicable’ will be to permit Single Entry mode and at the same time 

remaining the option of selecting the account during entry. 



 

 

Note: Exclude or include Groups are irrelevant when you specify a Ledger Name for which the class 

is created. They are useful when you select ‘Not Applicable’. 

In case you do not require split payments, you could create only one class with nothing in 

include/exclude Groups and without any ledger Name. A single class does not require class 

selection and is a rapid way of using Single Entry mode with full functionality of all ledgers available. 

Accept the class table and the voucher type alteration. You may use [CTRL] + [A] combination. 

PAYMENT VOUCHER ENTRY WITH CLASSES 

Select Voucher Entry at the Gateway of Tally. Press F5: Payment. You have to select a class or Not 

Applicable if no class is desired for this entry. If Cost Centre Class has been set, it can be selected 

too. 

The entries will be made as 

PURCHASE ENTRIES INVOICE MODE (WITHOUT CLASSES) 

Purchase Voucher can now be created in Invoice mode. You can enter the suppliers’ invoices in the 

same way as they physically appear. 

Set-up Invoice Mode entry for Purchase transactions 

1. Select F11: Company Features. 

2. Select F1: Accounting Features. 

3. Set the option ‘Allow Invoicing’ to Yes. 

4. Enter Purchases in Invoice Format? Set it to Yes. 

5. Accept the screen using Ctrl + A. 

 Content / Topic 15: apply tally to entry of purchasing voucher in invoice 

a) Entry  of purchase vouchers in invoice mode 

Select F9: Purchase. Select As Invoice button or use CTRL+V. This button is a toggle for Invoice and 

Voucher modes. You may want to use the voucher mode for more complex entries. 

Entries are exactly like sales invoices and hence are not discussed. 



 

 

 

The treatment of additional cost of purchase needs elaborating. 

 

 Content/Topic 16 : Apply tally 9 for enabling multiple currency  

a) Multiple currency in tally  

Enable Multi-Currency feature to view and enter transactions in multiple currencies. 

1. Go to Gateway of Tally 

2. Select F11: Features > Accounting Features> to display the Company 

Operations Alteration screen 

3. Set Allow Multi-Currency? to Yes 

4. Accept to Save. 

Multi-Currency feature is now enabled 

CURRENCIES MENU 

View the Currencies menu from Gateway of Tally > Accounts Info > Currencies. 

b) Creating a Currency 

Use ASCII Special Characters with [Alt] key combination if our keyboard does not have the symbol. 

Utilities like Character Map (Start>All Programs>Accessories> System 

Tools) in Windows shows the key combination for most symbols. This might be different on some 

notebook computers, refer to the computer’s user manual or the vendor. 

You cannot assign a duplicate currency symbol for a company in Tally. 



 

 

The Key combinations for a few currency symbols are given below: 

1. Alt + 156 – Pound Sterling - £ 

2. Alt + 0165 – Japanese Yen - ¥ 

3. Alt + 0128 – Euro - € 

4. Use the Dollar and the Rs. Symbol from the keyboard. 

To create a foreign currency 

1. Go to Gateway of Tally > Accounts Info.> Currencies> Create 

 

2. Enter the currency symbol in Symbol. This symbol appears in your reports wherever applicable. 

3. Enter the name of the currency in Formal Name. 

A formal name is required to distinguish different currencies with the same symbols. For e.g. you 

have created two companies (ABC and PQR) in Tally. ABC and PQR have different set of currencies. 

ABC uses symbol $ for Australian Dollars and PQR uses the symbol $ for U.S. Dollars. The formal 

name. Distinguishes two different currencies with the same symbol when you compare accounts of 

two companies. 

The company that is loaded first retains the original symbol for display purposes. 

The other company’s currency symbol will be prefixed with the first letter/first letters (to make it 

unique) of the formal name. Here, if ABC is loaded first then the symbol $ is for Australian 

Dollars and in PQR (loaded next) the symbol $ is prefixed with the letter U (first letter of its formal 

name). 



 

 

e.g., US Dollars, Pound Sterling, Indian Rupees, Omani Rial, etc. 

Note: You cannot assign a dup0licate Formal Name for a company in Tally. 

4. Enter the number of decimal places for the currency in Number of Decimal Places. E.g. Currencies 

with 2 decimal places like paisa and currencies with three decimal places like diner. There are 

currencies that do not have decimal places, e.g., Vietnamese Dong 

5. Tally has two formats for displaying an amount, viz., in millions and in lakhs. 

1000000 (one followed by six zeroes) in millions format would appear as 1,000,000 and lakhs would 

appear as 10, 00,000. 

Selecting No means you want amounts to appear in lakhs. 

Note: You can always specify the appearance of numbers in specific reports, e.g. In Profit & Loss 

Account display, press [F12]: Configure to change scale factors for values. 

6. Set Is Symbol SUFFEXED to Amounts? to Yes for the symbol to appear after the amount. Set to 

No for the symbol to be prefixed to the amount. 

7. Set Put a SPACE between Amount and symbol? to Yes to apply a space between amounts and 

symbol. 

8. Enter the symbol for decimal portion of currency in Symbol for Decimal Portion of Amount. E. g. 

Ps.For Paisa. 

9. Enter the number of decimal places for printing the amounts in words in Decimal Places for 

Printing Amounts in Words. This number should be equal to or lesser than the number specified in 

Number of Decimal Places field. 

Note: The Currency cannot be translated or transliterated but will appear in the Language 
created. 
 

c) ALTER CURRENCY 

You can modify or delete a currency master using the Alter option. Rates of Exchange can also 

be altered from here. 

To alter a currency master: 

1. Go to Gateway of Tally > Accounts Info.> Currencies> Alter 

2. Select a Currency from the Currencies list (displayed if there is more than 1 currency) 

3. In the Currency Alteration screen alter details as required. For details see 

Creating a Currency Master 



 

 

 
 

d) DISPLAYING A CURRENCY 

The currency Display screen displays the details and rates of exchange for a selected currency. 

To display the Currency screen. 

1. Go to Gateway of Tally > Accounts Info.> Currencies> Display 

2. Select a Currency from Currencies list (displayed if there is more than 1 currency) 

3. Enter to view the details 

d) DELETING A CURRENCY 

To delete a Currency 

1. Go to Gateway of Tally > Accounts Info.> Currencies> Alter 

2. Select a currency from the Currencies list (displayed if there is more than 1 currency) 

3. Press Alt + D in the Currency Alteration screen to delete 

Note: You cannot delete a Currency that has been used in a voucher transaction. 

e) RATES OF EXCHANGE 

Rate of Exchange is a feature wherein you can enter the rate of foreign currency for a specific date. 

Foreign exchange variations occur every day with different selling and buying rates. Rate of 

Exchange helps you apply the rate for the given date in your transactions. 



 

 

 

To open Rates of Exchange: 

1. Go to Gateway of Tally > Accounts Info.> Currencies> Rates of Exchange 

2. The Multi-Currency Alteration screen is displayed 

3. Enter the date for which the exchange rate is applicable 

4. Enter the Standard Rate (optional) which is used to calculate variances from the actual 

transaction rates 

5. Enter the Setting Rate (your setting rate) 

6. Enter the Buying Rate (your buying rate) 

7. Accept to Save 

Note: Last Voucher Rate is displayed if any voucher has been entered earlier. 

 

L O .3.3 – Understanding tally and introduction to taxation 

 Content /Topic1 : Introduction to Taxation in tally 9 

a) Tax deducted at source 

Tax Deducted at Source (TDS) is one of the modes of collecting income tax. The buyer (Deductor) 

deducts the tax from the payment made to the seller (Deductee) and remits the tax to the Income 

Tax Department within the stipulated time. 

The buyers (Corporate and Non-Corporate) make payment (such as Salary, Rent, interest on 

securities, Dividends, Insurance Commission, Professional Fees, Commission on Brokerage, 



 

 

Commission on Lottery Tickets, etc) to the sellers (Services) and deduct the requisite amount form 

such payments towards tax. 

The buyer files the TDS returns containing details of the seller and the bank, where the TDS amount 

is deposited to the Income Tax Department (TDS). 

The Income Tax Department has prescribed the formats for filling these returns electronically, 

which the buyer does in a CD/floppy. 

b) Tax Deducted at Source IN TALLY 

TDS (Tax Dedicated at Source) in Tally provides and easy-to-use and flexible interface. It helps you 

to handle intricate cases and calculate the tax payable to the Income Tax Department. 

Tally calculates the tax of all parties/suppliers where TDS deduction is mandatory. 

It calculates the TDS automatically and prints Formas per statutory requirement. It allows the user 

to view and print various TDS reports, Challans and TDS Outstanding statements. 

The TDS functionality in Tally supports the following features: 

1. Simple and user-friendly 

2. Quick and easy to set up and use 

3. Accounting for tax on partial/full payment of bills 

4. Flexibility for auto and manual calculation of TDS 

5. Complete tracking of each transaction from deduction to 

Payment. 

6. Challan management and printing for prompt and accurate filling of tax 

7. The Auto allocation feature prevents error-prone data entry and helps track the transactions 

faster. 

c) TDS COMPUTATION 

To view the TDS Computation report, 

Go to Gateway of Tally> Display > Statements of Accounts> TDS Outstandings> TDS Computations. 



 

 

 
1. The Particulars column provides you with the Name of the Party and its TDS ledger names. 

2. Amount Paid/Payable Till Date column displays the total amount of the Bills accounted or 

Payment made to the party 

3. The Tax column provides the amount of TDS computed as per the rate specified in the tax 

column, which is displayed below the TDS amount. 

4. Surcharge is the total surcharge value computed as per the rate specified in this column, which is 

displayed below the surcharge amount 

5. Addl. Surcharge (Cess) column displays the amount of Education Cess applicable as per the rate 

specified in this column, which is displayed below the Education Cess amount 

6. Addl. Education Cess column displays the amount of Additional Education Cess at 1% as 

computed 

7. Total TDS column displays the total TDS amount including all additional taxes 

8. Less: TDS Deducted Till Date column provides the TDS amount deducted till date 

9. Net TDS to Deduct column displays the TDS amount yet to be deducted formthe bills accounted 

or payment made. If TDS is deducted using TDS journal and if the complete amount of TDS due is 

deducted. This column will not display any balance. Partial amount deducted will display the 

balance amount of TDS to be deducted in this column. 

 Content / Topic 2. Use VAT in Tally 

a) INTRODUCTION TO VAT 



 

 

VAT is a system of indirect taxation, which has been introduced in lieu of sales tax. It is the tax paid 

by the producers, manufactures, retailers or any other who add value to the goods and that is 

ultimately passed on to the consumer.  

VAT has been introduced in Rwanda to ensure a fair and uniform system of taxation. It is efficient, 

transparent, revenue-neutral, globally acceptable and easy to administer taxation system. It 

benefits the common man (consumer), businessman and the Government. VAT enhances 

competitiveness by removing the cascading effect of taxes on goods and makes the levy of tax 

simple and self-regulatory, ensuring flexibility to generate large revenues. 

VAT was adopted because the Sales Tax system is complex and induces noncompliance. 

It has been found to be a hindrance in the economic growth of Industry, State and the Country. This 

causes a huge loss of revenue to the government. 

The cascading effect is brought about by the existing structure of taxation where inputs are taxed 

before a commodity is produced and the output is taxed after it is produced. This causes an unfair 

double- taxation.  

b) The concept of VAT 

Value Added Tax (VAT) is based on the value addition to the goods, and the related VAT liability of 

the dealer is calculated by deducting the input credit from the tax collected on sales during the 

payment period. 

This concept is explained with an example, in the Computation of VAT section. 

VAT works in two different ways: 

1. If VAT-registered business receives more output tax than the taxes paid as input, they will need 

to pay the difference to the Commissioner of Taxes (State). 

2. If the input tax paid is more than the output tax collected, 

· You can carry forward the Input credit and adjust it against the output tax in the subsequent 

months. 

· You can have the Input Credit refunded to you by the Government at her end of the current or 

following year. 

· You can receive refunds for Input Credit on exports within a period of three months. 

 Content / Topic 3 : Apply tally9 for creating journal voucher for VAT 

a) Creating journal Voucher for VAT 

If you need the Journal transactions for VAT Computation (for example, adjustment of Input credit, 

output tax, etc) you will need to make the following settings: 



 

 

Go to Gateway Tally> Accounts Info> Voucher type> Create/Alter 

The following screen is displayed 

 

Name of Class 

You have to name the voucher class. 

In the above example, we have named it as VAT Adjustment Class. Once you press Enter, the 

following screen is displayed. 

 

b) Use Class for VAT Adjustments 

Enable the option Use Class for VAT Adjustments to Yes, if you want the journal entries to be 

included in VAT Computation. 

c) JOURNAL ENTRIES 

Let us consider a Purchase transaction and then a reverse entry for adjustment of Input credit. 

The following screen displays a typical Purchase Transaction. 

Typical Purchase transaction 



 

 

 

 

Reversal of Input Credit 

1. Go to Journal voucher screen by selecting the button F7: Journal from the button bar, which is on 

the right side of the screen or by pressing the F7 key. 

2. You will see the following screen where you need to select the Voucher class created before. 

3. Once you select this you can pass the typical reversal entry as display below: 

 

Once you select this you can pass the typical reversal entry as shown below 



 

 

 

d) VAT Computation Report 

The VAT Computation report will be displayed as shown below. 

Note: Rs.50 of the Input credit is reversed and only the balance of Rs.50 can be claimed. 

Input Credit Adjustment for Capital Goods 

Input Credit for Capital goods is available over a maximum period of 36 monthly installments 

(States have the option to reduce the number of installments). The entry for the Purchase of Capital 

Goods is the same as in default Tally. 

Let us consider the following example for the adjustment of the Input credit. Purchase of Capital 

Goods for Rs. 500,000. The Input Credit is Rs. 20,000, which will be available over a period of 36 

monthly installments. That is, (20,000/36) =555.56 

Hence, Rs.555.56 can be claimed in the first installment as Input credit. 

The Journal entry for this is passed as shown below. 



 

 

 

INPUT CREDIT ADJUSTMENT FOR OPENING STOCK 

Sales Tax paid on unsold stock at the end of financial year, i.e. prior to commencement of VAT, is 

eligible to receive input credit on submission of the required documents by the dealer. For this, a 

claim is to be made to the VAT/ sub-VAT officer within 30 days of implementation of the Act. Once 

the assessing officer verifies it, the credit may be adjusted or refunded in equal installments over 

six months. 

JOURNAL ENTRIES 

In order to write off the Sales Tax incurred on closing stock in the next financial year, it is necessary 

to eliminate the tax change from the stock value of the current year. 

Assuming the local purchases amount to Rs. 57000 where Purchases @ 18% and Purchases @ 18% 

are Rs. 2000 and Rs. 37500 respectively, the transaction can be journalized as follows, selecting VAT 

Adjustment Class. (For more details on VAT adjustment class refer Journal) 



 

 

 

Debit the Current Assets account Tax Recoverable A/c and credit the purchase accounts. 

Following the grant of relief by the Assessing officer, you can pass a journal entry every month in 

the next financial (VAT) year, to adjust the sales tax paid in the previous year. 

To claim the installment credit at the end of each month, pass a journal entry upon selecting VAT 

Adjustment Class. 

 

The amount of Rs. 57500 is broken into six equal installments of Rs. 9583.33 and claimed at the end 

of each month. 

 

 

 

 



 

 

 Content/ topic 4: The features of service tax in tally 

Service tax integrated in Tally takes care of your service tax transactions. It eliminates error-prone 

information, incorrect remittance, penalties, interests, compliance issues, etc. Service Tax in Tally 

needs a one-time configuration for service tax features to be activated. 

1. Tally tracks bill-wise (bill-by-bill) detail and automatically calculates service tax payable and 

input credit with the flexibility to make adjustments later. 

2. Service tax is part of a regular transaction. Information on service tax is maintained and 

produced category-wise, which is mandatory in service tax returns. 

3. Adjusts input credit towards service tax payable. 

4. Accounts for abatement and expenses 

5. Provision for exemption notification details. 

6. Built-in assessable value feature on which service tax is calculated 

7. Transfer earlier pending service tax payable and available service tax input credit in to Tally 

8. Reports are generated as per government suggested format. Print and file reports. 

9. Management Information Services (MIS) reports: Service Tax Payable Report and Input 

Credit Form. 

 

COMPANY SERVICE TAX DETAILS 

The Company Service Tax Details screen in where you will enter the service tax details. The name of 

the company is displayed at the top followed by different fields. 

 

 



 

 

Company Service Tax Details 

Service Tax Registration No. - Enter the registration number allotted to you by the Service-Tax 

Department. 

Date of Registration – Enter the date of registration of Service Tax for your service. 

Assessee Code- Enter the code given to your company by in Service Tax Department. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Learning Unit 4: Introduction To Smart Gov 

L O4.1 - Meaning of SmartGov 

 Content/Topic 1 understanding of SMART Gov 

a) Meaning of SmartGov 

SmartGov is a cloud-based solution designed to help government organizations manage 

permissions, licenses, inspections, and more. The platform comes with a centralized dashboard, 

which enables users to automate approval processes and manage multiple workflows. 

SmartGov is a cloud-based software designed to supports local government authorities and city 

planners in managing key areas of community development.  

SMARTGov helps your jurisdiction work smarter and get more done. Use SMARTGov to streamline, 

automate and expedite all of your key activities -- permits, planning, inspections, code enforcement 

and citizen requests. 

The SMARTGov delivers many of the same capabilities you'd expect from expensive solutions used 

by large metropolitan areas, at an affordable price point. Learn more by watching this short video. 

SMARTGOV reduces the time and cost of permit processing by streamlining workflow and 

automating activities. 

SmartGov is a software company based in Cambridge (UK) that aggregates and processes layers of 

socio-economic data to make the socio-economics of a given location understandable and 

analysable. 

b) Cloud-based software 

A cloud application, or cloud app, is a software program where cloud-based and local components 

work together. This model relies on remote servers for processing logic that is accessed through a 

web browser with a continual internet connection. 

Benefits of cloud apps or software  

Fast response to business needs. Cloud applications can be updated, tested and deployed quickly, 

providing enterprises with fast time to market and agility. This speed can lead to culture shifts in 

business operations. 



 

 

Simplified operation. Infrastructure management can be outsourced to third-party cloud providers. 

Instant scalability. As demand rises or falls, available capacity can be adjusted. 

API use. Third-party data sources and storage services can be accessed with an application 

programming interface (API). Cloud applications can be kept smaller by using APIs to hand data to 

applications or API-based back-end services for processing or analytics computations, with the 

results handed back to the cloud application. Vetted APIs impose passive consistency that can 

speed development and yield predictable results. 

Gradual adoption. Refactoring legacy, on-premises applications to a cloud architecture in steps, 

allows components to be implemented on a gradual basis. 

Reduced costs. The size and scale of data centers run by major cloud infrastructure and service 

providers, along with competition among providers, has led to lower prices. Cloud-based 

applications can be less expensive to operate and maintain than equivalents on-premises 

installation. 

Improved data sharing and security. Data stored on cloud services is instantly available to 

authorized users. Due to their massive scale, cloud providers can hire world-class security experts 

and implement infrastructure security measures that typically only large enterprises can obtain. 

Centralized data managed by IT operations personnel is more easily backed up on a regular 

schedule and restored should disaster recovery become necessary. 

How cloud apps work 

Data is stored and compute cycles occur in a remote data center typically operated by a third-party 

company. A back end ensures uptime, security and integration and supports multiple access 

methods. 

Cloud applications provide quick responsiveness and don't need to permanently reside on the local 

device. They can function offline, but can be updated online. 

https://searchapparchitecture.techtarget.com/definition/application-program-interface-API
https://searchapparchitecture.techtarget.com/definition/application-program-interface-API
https://searchapparchitecture.techtarget.com/definition/refactoring
https://searchdisasterrecovery.techtarget.com/definition/disaster-recovery


 

 

While under constant control, cloud applications don't always consume storage space on a 

computer or communications device. Assuming a reasonably fast internet connection, a well-

written cloud application offers all the interactivity of a desktop application, along with 

the portability of a web application. 

L O.4.2 - Understanding features of SmartGov 

 Content /Topic 1 understanding the features of SMARTGov 

 The key features of SmartGov are the following; 

1. Permit issuance 

2. Purchasing and receiving 

3. Taxation and assessment 

4. Utility billing 

5. Report templates 

6. Speech recognition 

7. Accounting system integration 

8. Agency & staff performance reporting 

9. Code enforcement 

10. Code maintenance 

11. Cost recovery 

12. Failed inspection tracking 

13. Fee maintenance 

14. GIS 

15. Land planning 

16. License issuance 

17. Mobile integration 

18. Code enforcement: Is the act of 

imposing a set of rules, principles, or 

laws (especially written ones) and 

ensuring observance of a system of 

norms or customs. 

 

 

https://whatis.techtarget.com/definition/interactivity
https://searchstorage.techtarget.com/definition/portability


 

 

 

 

 

 

 

 

  



 

 

Learning Unit 5: Understand Electronic Single Window 

L O 5.1 - Models, tiers of capacity and types of electronic single window 

 Content/ Topic 1 : Description of electronic single window 

a) Definition of the term "single window" is: "A facility that allows parties involved in 

trade and transport to lodge standardized information and documents with 

a single entry point to fulfil all import, export, and transit-related regulatory 

requirements. 

The new electronic single window system, launched Wednesday in Kigali, will facilitate 

international trade by speeding up and simplifying information flows between traders and 

government institutions. 

“Rwanda being a land locked country, the need to introduce simplified systems that facilitate 

trade is more important, as this will create a conducive investment climate thus attracting more 

investments and economic growth,” the Minister of Trade, Francois Kanimbla, said at the 

launch. 

The Minister explained that the system takes less time to process and handle information 

between different stakeholders involved to clear goods. 

b) Models of electronic single window 

There are two major Electronic single window (ESW) models such as;  

I) The regulatory convergence model, generally driven by Customs. 

This model focuses on harmonizing procedures, electronic messages and data for submission, 

and sharing by Customs and other government agencies. 

 Under this model there are usually two levels of service: passive and interactive:  

1. Passive is an ESW that is a single portal for the collection of all data in a harmonized 

format. Participating agencies and other stakeholders query the portal to obtain the 

relevant data. No analysis or risk assessment is performed by the portal hub; 



 

 

2. Interactive has a collection portal resident in a government agency, usually Customs, that 

receives, analyzes, catalogues, and disseminates that data to the participating 

stakeholders.  

b)The trade-logistics model, which tends to be driven by trade and business interests. 

This model may include some Customs processes, it essentially revolves around the process, 

procedures, and data related to operating ports, transport, and similar facilities. This model 

requires the interactive level of ESW. 

c) Five Types of Electronic single model (ESW) using electronic messaging: 

There are five types of electronic single model such as; 

1. Business to Business (B2B); 

2. Business to Government (B2G); 

3. Government to Business (G2B); 

4. Government to Government - Domestic (G2G-D); 

5. Government to Government - International (G2G-I). 

d) Level or tiers of capacity of electronic single window 

Three levels of capacity were reviewed by the authors for consideration of which models and 

types to adopt based upon that capacity. Those levels reviewed are: 

a) Basic 

1. Lower volume of trade; 

2. Limited human and financial resources; 

3. No ICT for border transactions; 

4. No data harmonization. 

b) Medium 

1. Some ICT functionality for border formalities; 

2. Limited inter-agency communication and coordination; 

3. No data harmonization between agencies; 

4. Human and financial resources are available. 

c) High 

1. Current ESW in some form; 



 

 

2. May or may not have data harmonization between participating agencies; 

3. Incomplete functionality (not all stakeholders participating); 

L o 5.2 The steps for implementing electronic single window 

 Content/ topic 1 : Understanding the steps for implementation of ESW 

a) Steps for implementing 

Steps followed for implementation 

Key to successful implementation of electronic single window (ESW) for border integration is 

the creation of a strategic plan that addresses the many issues outlined in this and other similar 

studies about coordinated border management.  

The following are the basic steps to develop and deploy an ESW: 

1) Establish a project team tasked to develop a project management plan, which must be 

formally agreed by all parties. That plan should contain: 

a) A set of clearly defined interrelated tasks; 

b) Event milestones to assist in the planning execution, monitoring and evaluation, and 

adjustments to project implementation. 

2) Develop implementation options: 

a) Specifying proposed operational models; 

b) Relevant governmental authorities and agencies that would be involved; 

c) Suggested  lead governmental authority or agency or private organization; 

d) Services  to be provided; 

e) Potential  costs and benefits; 

f) Potential  sources for funding; 

g) Time frames for implementation. 

3) Project deployment: 

1) Step One: Focus on the Business Process, Not on the Function. It is critical to identify border 

functions essential to carrying out agencies’ responsibilities. Once this has been done, the focus 



 

 

must shift to the processes required to perform those functions, because they are the means by 

which the organizations interact wit other agencies and organizations; 

2) Step Two: Develop a Process Profile. Most processes in an organization are not fully 

documented, making it very difficult to accurately identify improvement opportunities. To the 

extent possible, utilize accepted business process improvement practices. In documenting 

processes, agencies need to follow the 80/20 rule. The application of this rule is obvious when 

applied to improvement initiatives because: 

 20 percent of the processes use 80 percent of the resources; 

 80 percent of the results are generated by 20 percent of the activities, and 

 20 percent of the problems represent 80 percent of the improvement opportunities. 

The Project Team should quickly identify a few resource-consuming processes as priorities for 

documentation. 

3) Step Three: Process Mapping. Have the processes been designed or have they evolved? In 

most agency administrations, the business processes were designed years ago. Most officials 

perform processes in the way they were taught. Over time, no one has ever gone back to 

review what is being done or why. Whatever was originally documented has since changed. As 

a result, most employees have never seen a visual representation of their work and do not 

know what is done before or after their own work. They don’t know how they fit into the big 

picture. 

A process map is a visual image of the way work is performed, showing: 

 Who performs what activities; 

 How inputs to a process become outputs; 

 How work flows and how rework loops back again and again; 

 When decisions need to be made; 

 What information is needed to support the process. 

4) Step Four: Measure the Processes. Process measurements allow agencies to determine 

current performance levels and establish quantifiable improvement targets. There are at least 



 

 

seven quantitative measures that can be used to determine the effectiveness of most business 

processes: 

1. Cost: The total cost of each activity in a process; 

2. Unit cost of process outputs: The cross-functional cost of producing tangible outputs; 

3. First pass yield: The percentage of transactions that make it through the process 

without being reworked, revised or rejected; 

4. Cost of rework: The cost of fixing the revised, reworked or rejected result; 

5. Process Cycle Time: The time required to generate a deliverable, such as minutes, days, 

weeks or months; 

6. Actual Cycle time: The time spent generating an output with no waiting or rework; 

7. Handoffs: The number of hands an item goes through and the activity at each hand (e.g. 

the number of signatures required on each document). 

5) Step Five: Studying other Administrations’ Processes. Ideas or proven processes in other 

agency administrations can provide invaluable information and save time, and possibly prevent 

mistakes. Examine case studies and best practices. 

6) Step Six: Process Redesign. Using the information gathered from the previous five steps, the 

Project Team can now map out the new processes, eliminating redundancies and duplicating 

work activities. 

7) Step Seven: Balance Processes and Technology. In most organizations, information systems 

are very closely tied to the way work is performed, but technology should be seen as a tool and 

not, in itself, a driving mechanism for change. Automating a manual process will not necessarily 

make an inter-agency administration more productive, and automating an ineffective process 

will simply get poor results faster. The Project Team should ensure that in improving processes 

and exploiting technology, the process review should come first so that technology 

recommendations can be based on its findings. 

8) Step Eight: Manage Process Change. The Project Team should manage change through prior 

identification and assessment of associated risks. There are many possible effects from change, 

and the Project Team should concentrate on those that are: 



 

 

1. Highly desirable but unlikely without specific actions, and 

2. Highly undesirable, but very likely without sufficient attention. 

9) Step Nine: Prepare People (Staff and Clients) for Change. Most staff resist change out of fear 

of what the future will bring, rather than from any positive attachment to the current process. 

The role of those who lead change is difficult and thankless; little training is available and there 

are few available role models for guidance and advice. Ideally, a formal Change Management 

Program should be provided for employees, which should follow a three-stage process to bring 

about acceptance of a change initiative: 

1. People need to intellectually understand the need to change. As much participation as 

possible will aid understanding. Organize structured training to: 

a. Update staff with any future changes; 

b. Provide refresher training where required; 

c. Train employees when job roles change; 

d. Conduct periodic quality audits. 

2. People need to become emotionally engaged in change because they see the improvement 

possibilities and benefits.  

3. People need to take personal action as participants and not be simply observers. 

10) Step Ten: Continuous Process Improvement. Business process re-engineering is time-

consuming, costly, and strenuous. Although change is sometimes mandatory, a culture of 

continuous process improvement will ensure that small improvements happen all the time and 

big changes happen infrequently. The job tasks of every employee should include: 

1. Continuous assessment of the situation and measurement of the change process; 

2. Identification of improvement opportunities, concentrating on high leverage improvements 

yielding the greatest return; 



 

 

3. Prompt action when improvement opportunities are identified and offer quick and tangible 

results; and, 

4. Measurement of results, translating change initiatives into quantifiable results. 

11) Step Eleven: Identify Funding Options. There are multiple models for funding an ESW. 

Those models are described in the previous JBC study on Coordinated Border Management and 

include self-funding, grants, and loans from development banks (e.g. IDB), fee for service, and 

combinations of each. 

12) Step Twelve: Identify Technology Specifications. 

1. Project Team create detailed specifications; 

2. Determine resources available; 

3. Scope of coverage. 

13) Step thirteen: Interview And/or Engage Technology Providers. Vendors are quite willing to 

discuss their systems and products in some detail. Take advantage of that service and request 

two or three vendors to conduct a brief needs assessment based upon specifications provided. 

1. See list of potential vendors 

14) Step fourteen: Procure Technology. 

1. Clearly state specifications 

2. Carefully consider timetables for delivery 

3. Resist desire for more functionality than needed to meet new business processes 

15) Step Fifteen: Develop an Implementation Timeline and Deploy in One Port as a Pilot 

1. Working with the technology provider, develop a timeline10 for the development and 

implementation of ultimate system. 

 As part of the timeline determine milestones and incremental deployment goals; 

 Identify single Port to test initial functions in short time frames, 



 

 

e.g. 3 to 6 months to demonstrate certain key applications. 

2. Have Team including technology provider meet with port management stakeholders (e.g., 

port operators, OGAs, carriers, traders) to include them in plans for pilot deployment 

3. Deploy 

16) Step Sixteen: Deploy to Other Border Stations in Stages As Participating Government 

Agencies and Stakeholders Develop Capacity. 

 

 

 

 

 

 

 

 

Learning unit 6: Understand the application of QuickBooks 

L O 6.1 –Accounts types and financial reports 

 Content/ Topic 1 : Discussion on the QuickBooks operation  

a) Opening a QuickBooks sample file 

To open a quickbooks sample file the  

From your open company file: 

1. Select the File menu at the top, select Open or Restore Company. 

2. Select Open a company file radio button, then select Next. 

3. From the Open a company window, select Cancel. 



 

 

4. On the “No Company Open” window, select “Open a Sample File” from the drop-down 

arrow. 

5. Create a portable copy using the sample company file and save it on your Desktop. 

b)  Four steps to be followed 

The four steps to while opening the sample file in quickbook are the following; 

1 Step one from the quickbook click file >>> Open or restore company 

 

 

2.Step two from Open or Restore company click Next 



 

 

 

3. Step 3 from open a company box click concel 



 

 

 

4. Step 4 From no company open select a company that you want to open >> click open 

 



 

 

 Content/ Topic 2: Apply quickbook for opening quickbook files 

a) Opening other QuickBooks Data Files 

Sometimes, a company file you want to open falls off the recent-file list. (The box on Fast 

Access to Several Companies explains how to tell QuickBooks how many files to include on the 

Open Previous Company submenu.) Say your bookkeeping business is booming and you work 

on dozens (loads) of company files every month.   Here is how to open any company file, no 

matter how long it’s been since you last used it: 

1. Choose File→ Open or Restore Company. 

If the No Company Open window is visible, you can click “Open or restore an existing 

company” instead. 

2. In the Open or Restore Company dialog box, select the “Open a company file” option 

and then click Next. 

The Open a Company dialog box appears. 

3. Navigate to the folder with the company file you want and double-click the file’s 

name. 

You can also click the filename and then click Open. 

4. If the QuickBooks Login window appears (which it will if you’ve assigned a password 

to the Administrator user account or set up multiple users), type your user name and 

password. 

If the Administrator is the only user, the Password box is the only one that appears. But 

if you have more than one user for the company file, both the User Name and Password 

boxes appear. 

5. Click OK. 

QuickBooks opens the company file, and you’re ready to keep the books. 

b) Opening multiple files 

To open more company files at the same time, With QuickBooks Accountant 

or QuickBooks Desktop Enterprise, Go to the File menu, then click open or restore company 

https://www.oreilly.com/library/view/quickbooks-2012-the/9781449317898/ch01.html#fast_access_to_several_companies
https://www.oreilly.com/library/view/quickbooks-2012-the/9781449317898/ch01.html#fast_access_to_several_companies


 

 

If you work on several sets of company books at the same time, choosing File →Open Previous 

Company is the quickest way to hop between company files. Out of the box, QuickBooks lists up 

to 20 companies on the Open Previous Company submenu. If you work with fewer companies, 

the submenu may have company files that you’d rather forget. 

You can change the number of companies QuickBooks lists on this submenu to match the 

number of companies you work with. With a clever workaround, you can also clear out old 

entries that you don’t want to see. Here’s how to change the number of companies on the 

Open Previous Company submenu: 

1. Choose File → Open Previous Company →“Set number of previous companies.” 

(You need to have a company file open to select this command.) 

2. In the Set Number of Previous Companies dialog box, type the maximum number 

of companies you want to see on the submenu, and then click OK. QuickBooks can show 

up to 20, which it lists starting with the most recent. 

 

 

 

 

 

L O6.2 –Understanding QuickBooks user interface features 

 Content/Topic 1 :description of quickbook interface features  

 Homepage 

 

 

 

The Home page gives you a big 

picture of how your business 

tasks fit together. It opens 

automatically whenever you 

open a company file. 

You can do all your tasks 

just using the menus. The 

menus contain the same 

tasks as the Home page, 

and more. 



 

 

 

 

c) Using centers 

 

 

 

QuickBooks tracks the people and companies you do business with in Centers. There is a 

separate QuickBooks Center for customers, vendors, and employees. Use the centers to 

manage and view all information and transactions associated with customers, vendors, and 

employees. 

All of the centers work the same way. We’ll use the Customer Center to show you how they 

work. 

The Icon Bar includes 

shortcuts to many parts of 

QuickBooks. To create 

your own shortcuts, click 

Customize Shortcuts. 

Go directly to the 

centers by clicking on 

these icons, 

(Venders, Customers 

and Employees). 

Go directly to the 

centers by clicking on 

these icons, 

(Venders, Customers 

and Employees). 



 

 

 

 

d) Company Snapshot 

Use the Company Snapshot to get real-time company information and perform tasks from a 

single place. 

To start, go here: Company > Company Snapshot. 



 

 

 

 

 Content/ Topic 3 :Apply quickbook to produce income tracker 

Income tracker 

 The Income Tracker makes it easy to find and work with your unbilled sales (estimates, sales 

orders, and time & expenses), unpaid sales (open and overdue invoices), and paid sales 

(payments and sales receipts). 

To open the Income Tracker, choose Customers > Income Tracker. 



 

 

Note: The Income Tracker isn't available if multicurrency is turned on. 

 

 

 

Icon bar  

 The Icon Bar contains shortcuts to the tasks and reports you use most. You can place the Icon Bar to the 

left of the QuickBooks desktop or above it. We recommend using the Left Icon Bar because it offers 

more power and versatility. 



 

 

 

Calendar 

The QuickBooks Calendar is a quick way to view transactions and tasks you've entered into 

QuickBooks. Use the following preferences to control how the calendar appears each time you 

open it. These preferences also control which transactions appear on the calendar. 



 

 

 

L O6.3 - Entering transactions in QuickBooks 

 Content/ Topic 1 : Apply quickbook to record transaction 

a) Computer practice No1, steps 

Step 1. Set up or add a new chart of account 

Step 1. Creation of purchase order 

1. From quick book home page, click purchase order >> select vender and drop ship to 

(customer ) 

2. Select item and quantity select also the customer 

3. Click save and close 



 

 

 

Step 2. Receive inventory with bill 

1) From the quickbook home page, click receive inventory >> select inventory with bill 

2) Select vendor >> item and quantity then 

3) Click save and close 

 

Step 3. Enter bill against inventory 

1) From the quickbook home page click enter bills against inventory 

2) Select vendor then click ok  

Step 4 pay bill 



 

 

1) From the quickbook home page click pay bill 

2) Select filter by to select vendor 

3) Select bill that you are going to pay  and select bank then  

4) Click pay selected bill  

 

 

 Content/ Topic 2 : Apply quickbook for selling product to the customers 

Computer practice No2, steps Selling product to the customers 

Step1. From quickbook homepage click create invoices >> select a customer  

2.Select product invoice template  

3. Select purchase order number  

4. Select quantity sold and amount 

5. Click save and close 



 

 

 

Step 2. Receive customer payment 

1. From quickbook homepage click receive payment 

2. Select a customer  

3. Select if customer payment is made by cash or by check 

4. Click save and close 



 

 

 

Step 3 record deposit  

1. From quick book homepage, click record deposit 

2. Accept payment 

3. Click ok 



 

 

 

 

 Content/topic 3 : the steps followed to generate the financial reports 

The steps to generate the deferent reports in quickbook are as follow; 

1. From the report the quickbook menu click reports, and different reports are appears, 

2. Click on the company financial reports. This is used when the used want to generate the  

financial report like; the profit and loss report, balance sheets report and cash flow 

forecasts 



 

 

 

3. Click on the report that you want to generate, for example balance sheet, and then,  

4. Click ok 

 

 



 

 

 

 

Reference(s): 

APA format 

1. Computer application in accounting software (TALLY): step by step learning guide and 

solution to problems Vairavan - Kalamohan Creations Pte Ltd. – 2010 

2. P.K. MacBride - Sage Accounting In Simple Steps (2011, Pearson International) - 

libgen.lc 

3. QuickBooks online for dummies Marmel - John Wiley & Sons, Inc. - 2018 

4. A practical introduction to Sage Line 50 Weale - Babani – 1999 

5. The SAGE handbook of European foreign policy Jorgensen et al. - SAGE – 2015 

6. QuickBooks online for dummies Marmel - John Wiley & Sons, Inc. – 2018 

7. The emotional intelligence quickbook: Everything you need to know Bradberry& 

Greaves - Talentsmart – 2003 

8. Computerized accounting using Sage 50 Accounting 2015 Arens et al. - Armond Dalton – 

2015 

9. Computerized accounting using Sage 50 Accounting 2017 Arens et al. - Armond Dalton 

Publishers, Inc. – 2017 

10. Computerized accounting with sage 50 2015 Jim - Paradigm Publishing, Inc – 2015 

11. Computerized accounting with Sage 50 2016 Mazza& Chavez - Paradigm Education 

Solutions – 2016 

12. Accounting Warren et al. - South-Western/Cengage Learning – 2014 

13. Computerized accounting with sage 50 2017, text MAZZA - PARADIGM Publishing, INC – 

2017 

14. SmartGov: renewing electronic government for improved service delivery Curthoys& 

Crabtree - Work Foundation – 2003 

15. Northern New Jersey significant areas of development: tally Land Use Planning Section, 

Office of Transportation Planning, the Port Authority of NY and NJ – 1988 

16. Computer accounting with QuickBooks 2013 Kay - McGraw-Hill/Irwin - 2013 



 

 

 https://www.integra-accounting.co.uk/pdf/IAL%20Sage%20Manual%20V%2012.pdf 

Sage Accounting A Step by Step Guide 26th June 2020 

 https://www.getapp.com/government-social-services-software/a/smartgov/ Smart 

Gov27th June 2020 

 http://ncsmindia.com/wp-content/uploads/2012/04/TALLY-9.0-PDF.pdf features in 

tally, 20th June 2020 

 https://www.meettally.com Tally is a credit card consolidation app that helps you pay 

off debt faster, save money, manage your cards all in one and schedule payments.19th 

June, 2020 

 https://www.merriam-webster.com/dictionary/tally Tally definition is - a recorded 

reckoning or account (as of items or charges) 15th /June 2020  

 help.smartgovcommunity.com/help/Implementation .htm Introduction To take advantage of 

everything SMARTGov Community has to offer you must go through a process called 

implementation. 15th ,06 2020 
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